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Johdanto ja käyttötarkoitus 

Tämä dokumentti sisältää ohjeet (Water Shed Safety Plan) eli WSSP:n toteuttamiseen. Ohjeiden 
tarkoituksena on neuvoa lukijaa luomaan WSSP-paikkatietokannat. Ohjeissa oletetaan, että lukijalla on 
perusosaaminen paikkatiedosta. Ohjeet on kirjoitettu QGIS 3.22.7, jonka kautta kaikkia FOSS4G 
geospatiaalisia kirjastoja (GDAL) sekä - sovelluksia (GRASS GIS) käytetään. Ohjeet eivät välttämättä toimi 
muilla QGIS-versioilla, eivätkä toimi ilman GRASS GIS sovellusta. Pilotointi toteutettiin Windows 10 
käyttöjärjestelmällä.  

WSSP on tarkoitettu viranomaiskäyttöön hulevesien turvallisuuspohjaiseen valuma-aluetarkasteluun. 
WSSP:n avulla voidaan tutkia hulevesien taajamien alueellisia riskejä, tarkastella maankäyttöä ja 
muutosalueita, muodostaa taajamissa valuma-alueita. 

Kaikki WSSP:sa käytetyt menetelmät ovat tyypillisiä paikkatiedon menetelmiä. Lähtöaineistot ovat valmiiksi 
tuotettuja, joita muokkaamalla päästään haluttuun lopputulokseen, kenttädataa ei tarvitse kerätä. 
Hulevesiviemäriverkon ja yleiskaavan tekninen piirustus ei ole välttämättä avointa aineistoa sidosryhmien 
ulkopuolisille ryhmille. WSSP:sa on myös sovellettu muutamia maksuttomia liitännäisiä työskentelyn 
helpottamiseksi. Näiden käyttö on suositeltavaa.  

Ohjeiden yksikkönä toimii aina metrit, ellei toisin mainita. Koordinaatistona käytetään ensisijaisesti 
EPSG:3067, ETRS-TM35FIN – järjestelmää, ellei toisin mainita. Ohjeiden osittaisena käyttökielenä on 
englanti, johtuen QGIS:n puutteellisesta suomenkielisestä käännöksestä. 

Yksiköt voi vaihtaa metreiksi: Options -> Map tools 

Kielen voi vaihtaa: Options -> General. Asetusten vaihtamisen jälkeen ohjelma on käynnistettävä 
uudelleen. 

Koordinaattijärjestelmän asetukset voi vaihtaa: Options -> CRS 

WSSP-ohje koostuu kolmesta moduulista: 

1. WSSP valuma-aluemoduulissa määritellään tarkasteltavan vesistön valuma-alueet ja tarpeen mukaan
osavaluma-alueet.

2. WSSP Maankäyttöluokka- ja muutosaluemoduulissa luodaan hulevesien maankäyttöluokittelu ja
paikannetaan muutosalueet.

3. WSSP-riskimoduulissa kartoitetaan hulevesien alueelliset riskit.
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Valmistelut ja aineistot 

 
Kuva 1. Kuvituskuva. Pilottialueen kolmiulotteinen kartta. 
 

Ennen WSSP:n aloittamista on suositeltavaa lukea tai tutustua WSSP tietokantaan ja HULVATTU 
loppuraporttiin. Tietokanta sisältää kaikki WSSP-työkalun paikkatietoaineistojen selitykset sekä WSSP-
moduulien kuvailut. 

Ohjeiden käyttö 
Ohjeiden seuraamisen nopeuttamiseksi voidaan käyttää hakutoimintoa. Standardinäkymässä hakutoiminto 
(Ctrl+ k), löytyy QGIS:n vasemmasta alanurkasta. Ohjeissa hakutermi on väritetty punaisella.  Käyttämällä 
hakutoimintoa, ohjeissa esitettyä polkua ei ole pakko seurata, vaan hakutermin voi kopioida suoraan 
hakupalkkiin. QGIS sisältää toisinaan useita samannimisiä -ja kaltaisia työkaluja, joten hakutoiminnon 
kanssa on syytä olla tarkka! 
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Kuva 2. Hakutoiminto 

Kursiivilla viitataan joko tason nimeen kuten ”polttotaso.” Sillä voidaan myös viitata toimintoon, työkaluun 
tai parametriin kuten layers panel. Lihavoinnilla korostetaan kriittisiä tai huomionarvoisia asioita. 

Batch processing 
Ohjeissa on toisinaan tarve toteuttaa prosessi erissä. Tällä tarkoitetaan batch processing -toimintoa. 
Toiminnon avulla voidaan toteuttaa työkaluja erissä, valitulle määrälle aineistoa. Esimerkiksi useita eri 
tasoja voidaan leikata samanaikaisesti. Toiminnolla voidaan asettaa samat, tai eri parametrit eri tasoille. 

 
Kuva 3. Batch processing, Processing toolbox -kautta. 
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Kuva 4. Batch Processing työkalun kautta. 

Extent/ GRASS region extent 
Useissa GRASS- työkaluissa on mahdollista säätää työkalu toimimaan tietyllä alueella. Laskettava alue 
voidaan piirtää työtilaan hiirellä, valita työtilan ikkunasta, asettaa koordinaateilla tai piirtää valitusta 
tasosta. Mikäli toiminto on tarjolla, asetus löytyy joko suoraan työkalusta tai Advanced parameters -> Grass 
region extent. 
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Kuva 5. Extent. Laskualueen rajaus rasteritasolla. 

Avataan tason välilehti 
Ohjeissa tason välilehdellä tarkoitetaan tasoikkunasta (layers panel) avattavaa ikkunaa, jossa on useita eri 
toimintoja. Muun muassa tason ominaisuudet, tyylit ja attribuuttitaulukko sekä geometry calculator -
liitännäinen löytyvät tason välilehdeltä.  
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Kuva 6. Tason välilehti. 
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Kenttälaskin (Field calculator) 
Kenttälaskimeen pääsee käsiksi attribuuttitaulukon kautta, joko avaamalla tason välilehden tai valitsemalla 
attribuuttitaulukon työkaluriviltä (Ctr+i) tai Open field calculator  

 
Kuva 7. Kenttälaskin. 

Aineiston tiputtaminen työtilaan 
Ohjeissa viitataan usein aineiston ”tiputtamiseen”. Tällä tarkoitetaan yksinkertaisesti aineistojen liittämistä 
työtilaan. Liitettävät tiedostot valitaan sekä raahataan layers panel päälle ja tiputetaan. Kaikki QGIS:n 
tukemat tiedostomuodot voidaan liittää työtilaan kyseisellä tavalla.  

Kuvien seuraaminen 
Johtuen pilotoinnin ja ohjeiden testauksen pituudesta, kaikki kuvat eivät ole ajantasaisia. Kirjalliset ohjeet 
menevät aina kuvien esittämien parametrien ja toimien edelle. Kuvat on tarkoitettu täydentämään 
kirjallisia ohjeita, eikä niitä ole pakollista hyödyntää. 

Digitointi 
Digitoinnilla viitataan vektoritason muokkaamiseen Vertex tool -työkalun avulla. Digitointia ei erikseen 
ohjeisteta WSSP:sa, vaan oletetaan, että lukija kykenee digitoimaan omatoimisesti. 
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Tallentaminen väliaikaisena 
Ohjeissa väliaikaisella tallentamisella viitataan QGIS:n luomiin väliaikaisiin tasoihin. Halutessaan kaikki tasot 
voidaan tallentaa pysyvästi, tunnistettavalla tavalla. Vaihtoehtoisesti memory layer saver -liitännäinen 
tekee tasoista pysyviä. 
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Linkit avoimiin aineistoihin 
Tämä osio sisältää linkit kaikkiin hyödynnettävissä oleviin avoimiin aineistoihin. Aineistot tulee korvata 
uudemmilla ja tarkemmilla aineistoilla sitä mukaa, kun niitä julkaistaan. 

HUOM! Kunnallinen aineisto, kuten hulevesijärjestelmän ja kaavan tekniset piirrokset eivät ole avointa 
aineistoa sidosryhmien ulkopuolisille käyttäjille. Niiden käyttö on kuitenkin välttämätöntä WSSP:n 
parhaan mahdollisen toteutuksen kannalta. 

Maanmittauslaitos 

Aineistot: Korkeusmalli 2 m, Ilmakuvat, Maastotietokanta 

https://asiointi.maanmittauslaitos.fi/karttapaikka/tiedostopalvelu  

Suomen ympäristökeskus 

Aineistot: NVDI 

https://ckan.ymparisto.fi/dataset/ndvi-n-maksimiarvo-v-2021  

Geologian tutkimuskeskus 

Aineistot: Maaperä 1:20 000 / 1:50 000 

https://hakku.gtk.fi/fi/locations/search  

European Environmental Agency 

Aineistot: Imperviousness Density 2018 

https://land.copernicus.eu/pan-european/high-resolution-layers/imperviousness/status-
maps/imperviousness-density-2018  

Luonnonvarakeskus 

Aineistot: Puuston keskipituus 2019 (dm), Puuston latvuspeittävyys koko puusto 2019 

https://kartta.luke.fi/opendata/valinta.html 

  

https://asiointi.maanmittauslaitos.fi/karttapaikka/tiedostopalvelu
https://ckan.ymparisto.fi/dataset/ndvi-n-maksimiarvo-v-2021
https://hakku.gtk.fi/fi/locations/search
https://land.copernicus.eu/pan-european/high-resolution-layers/imperviousness/status-maps/imperviousness-density-2018
https://land.copernicus.eu/pan-european/high-resolution-layers/imperviousness/status-maps/imperviousness-density-2018
https://kartta.luke.fi/opendata/valinta.html
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Liitännäiset 
Kaikki käytetyt liitännäiset ovat maksuttomia. Liitännäiset eivät ole välttämättömiä, mutta ne helpottavat 
työskentelyä. Ohjeet on kirjoitettu liitännäisiin nojaten. Kaikki käytetyt liitännäiset voidaan asentaa 
suoraan QGIS:n kautta.  

• autoSaver  
• Multipart Split 
• Geometry calculator 

 

Liitännäisten asennus 
Asenna ylempänä luetellut liitännäiset. Seuraa asentamisessa lisäosan tarjoajan ohjeita, mikäli tarpeellista. 

1.  Avataan liitännäishallinta. Tämä löytyy ylimmältä riviltä. Plugins -> Manage and install plugins -> All. 
Kirjoitetaan hakuriville asennettavan lisäosan nimi ja asennetaan lisäosa. -> Install plugin.  

2. Toistetaan vaihe 1. uudelleen kunnes kaikki liitännäiset on asennettu.  

autoSaver -liitännäinen tallentaa työtilan ja tasojen muokkaukset käyttäjän määrittämässä aikaikkunassa ja 
vähentää ylivoimaisten esteiden (ohjelmiston kaatuminen, sähkökatko) aiheuttamaa työhävikkiä. Lisäosa 
täytyy muistaa kytkeä päälle aina, kun työtilan aukaisee. Asennuksen jälkeen lisäosa löytyy Data Source 
Manager Toolbar -työkaluriviltä.  

Multipart Split on editointityökalu, jonka avulla voidaan nappia painamalla muuttaa moniosaiset 
geometriat yksiosaisiksi. Asennuksen jälkeen lisäosa löytyy Advanced Digitizing Toolbar -työkaluriviltä. 
Liitännäisen käytön voi kiertää singleparts to multiparts -komennon avulla. 

Geometry calculator nopeuttaa vektorien pinta-alan laskemista. Asennuksen jälkeen liitännäinen löytyy 
tason välilehdeltä (layers panel). Liitännäisen käytön voi kiertää kenttälaskimen avulla. 

 
Kuva 8. Autosaver -liitännäiset ja autosaver kuvake. Oikealla multipart split kuvake. 
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Kuva 9. Geometry calculator -liitännäinen. 

  



 

14 
 

Yleiskaavan ja hulevesiverkoston tekniset vaatimukset WSSP:sa 
Korkeusmallin hydrologisessa eheyttämisessä apuna toimii kunnallinen hulevesiviemäriverkosto. WSSP-
maankäyttöluokituksessa ja muutosalueiden paikantamisessa lähtöaineistona toimii yleiskaava.  

Paras mahdollinen tulos saadaan, kun hulevesiverkosto ja yleiskaava hankitaan: 

1. QGIS:in tukema vektoritiedostona. 
2. Teknisenä piirustuksena .DWG- tai .DFX-muodossa. (QGIS ei tue 2018–2020 AUTOCAD-piirroksia). 

Yleiskaavan on oltava topografisesti ehjä ja geometrialtaan monikulmio. Kaavan epäjatkuvuudet, 
limittäisyydet ja reiät vaativat korjausta sekä tarkoittavat lisätöitä, tai korjaamatta jätettäessä vääristävät 
tuloksia, riippuen topografian rikkinäisyydestä.  

Jokaisella yleiskaavan kohteella tulee olla kaavanmukaista käyttötarkoitusta vastaava ominaisuustieto. 
Käyttötarkoitusta vastaava ominaisuustieto on oleellinen, sillä ilman sitä ei voida luokitella maankäyttöä. 
Ideaalisesti ominaisuustietona on yleiskaavan käyttötarkoitusta vastaava lyhenne (AS, AS/l, V, W, VP jne.) 
Mikä tahansa käyttötarkoitusta merkitsevä ominaisuustieto käy, kuten numerosarja. 

 
Kuva 10. Vasemmalla monikulmiomuotoinen ja jatkuva kaava. Värit osoittava kaavanmukaisen käyttötarkoituksen. Oikealla viivamuotoinen 
kaava, jossa käyttötarkoitusta ilmaisee erillinen pistetaso. 

Hulevesiverkoston on oltava jatkuva ja geometrialtaan viiva. Epäjatkuvuuskohdat tuottavat virheitä 
valuma-alueiden laskuissa, mutta eivät estä WSSP:n toteuttamista. Hulevesiviemäriverkosto ei vaadi 
ominaisuustietoa, sillä nykyisellään WSSP hyödyntää pelkästään ”uomien” sijaintitietoa. 

https://docs.qgis.org/2.8/en/docs/user_manual/working_with_vector/supported_data.html
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Kuva 11. Vasemmalla hulevesiverkoston mukana on tarpeetonta dataa, (ruskeat ja mustat viivat), joka tekee työstä raskaampaa. Pääuoma on 
epäjatkuvien sinisten viivojen edustama. Oikealla ei ole ylimääräisiä tasoja ja data on yhtenäisempää. 
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WSSP valuma-aluemoduuli 
  

 
Kuva 12. Kuvituskuva. Erään pilottialueen päävesistöön päätyvät osavaluma-alueet. 

Tiivistelmä  
Moduulin avulla pystytään määrittämään kaupunkivaluma-alueet, huomioiden hulevesiviemäriverkon 
osien peitteisyyden. On suositeltavaa luoda erillinen työtila WSSP valuma-aluemoduulia varten. Tämän 
moduulin tavoitteena on: 

• Luoda valuma- ja osavaluma-alueet osavaluma-alueet  
• Luoda ”yhdistetty korkeusmalli” 
• Luoda ”polttotaso” 
• Luoda ”poltettu korkeusmalli” 

Moduulissa tarvittavat lähtöaineistot: 

• Korkeusmalli 2 m 
• Maastotietokannan mukaiset vaka- ja virtavedet 
• Kunnallinen hulevesiverkosto  
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Valuma-alueiden määrittämiseksi kaupunkiympäristössä WSSP hyödyntää MML Korkeusmalli 2 m -
aineistoa. Jotta hulevesiviemäristö saadaan edustetuksi korkeusmallissa, käytetään WSSP:sa menetelmänä 
polttamista. Tällä tarkoitetaan sitä, että korkeusmallin hilojen arvoja lasketaan ennalta määritetyistä 
paikosta. WSSP:sa koko vesiverkostoa lasketaan samanarvoisesti niin kutsutun polttotason avulla.  

WSSP:hen valittu valuma-aluetyökalu r.watershed ei vaadi korkeusmallin täyttämistä. R.watershed 
ohittaa korkeusmallin nielut, niin kutsutun least-cost-algoritmin avulla. Ohjeissa ei esitetä, kuinka 
korkeusmalli täytetään. Mikäli r.watershed korvataan jollakin toisella valuma-aluetyökalulla, on 
korkeusmallin nielujen täyttö tehtävä ennen valuma-alueiden muodostamista. Täyttämisessä voidaan 
käyttää GRASS GIS: r.fill.dir tai SAGA GIS: Fill sinks, Fill sinks (wang & liu), Fill sinks xxl (wang & liu) - 
työkaluja. 

Esivalmistelut ja korkeusmallin luominen 
On tiedettävä karkeasti, kuinka suurelle alueelle tarkasteltava valuma-alue ylettyy, jotta valuma-alueen 
määrittelyyn tarvittava osa hulevesiverkostoaineistoa voidaan hankkia. Lisäksi aineistontarjoajalta tulee 
pyytää myös metatiedot. Metatiedon puuttuessa, vähin mitä tarvitaan on aineiston 
koordinaattijärjestelmä. Mikäli koordinaattijärjestelmää ei tunneta, aineistoa ei saada sijoitettua oikein. 

1. Luodaan työtila. Tallennetaan työtilan tunnistettavalla nimellä. 

Mikäli tarkasteltavan alueen hulevesiverkosto on kokonaan hyödynnettävissä, eikä erillisiä 
aineistopyyntöjä tarvitse tehdä, voidaan ohittaa kohdat 1a–1 c ja siirtyä suoraan kohtaan 2. 

1.a Tarkasteltavalta alueelta rajataan valuma-alue selainpohjaisella työkalulla. Karkean alustavan rajauksen 
voi tehdä selaimessa SYKEN Value valuma-alue-työkalua hyödyntäen.  

1.b Tarkasteltavalta alueelta rajataan valuma-alue selainpohjaisella työkalulla. Karkean alustavan rajauksen 
voi tehdä selaimessa metsäkeskuksen valuma-alue työkalua hyödyntäen.  

1.c Määritetään valuma-alue käsin. 

2. Ladataan lähtöaineisto valuma-alueen määrittämiseen. Määrityksessä lähtöaineistona toimii 
Maanmittauslaitoksen Korkeusmalli 2 m. Aineisto ladataan GeoTIFF-kuvina.  

Kuvia tulisi ladata riittävän kattavasti. Erityisen tärkeää on, ettei tarkasteltava valuma-alue ole liian lähellä 
kuvan reunaa, koska reunan lähellä syntyy eniten valuma-alueiden vääristymiä. 

3. Puretaan ladatut tiedostot ja tiputetaan aineisto työtilaan. Tarkistetaan sijainti world-komennolla. 
Komento kirjoitetaan työtilassa alareunan koordinaattiriville ja painetaan syöttönäppäintä. Coordinate -> 
World 

https://paikkatieto.ymparisto.fi/value/
https://metsakeskus.maps.arcgis.com/apps/webappviewer/index.html?id=4ab572bdb631439d82f8aa8e0284f663
https://asiointi.maanmittauslaitos.fi/karttapaikka/tiedostopalvelu/korkeusmalli
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Kuva 13. Sijainnin tarkistaminen World -komennolla. 

 

4. Yhdistetään ladatut geoTIFF-kuvat. Processing-> Processing toolbox -> GDAL->Raster Miscellaneous-> 
Merge 

5. Valitaan yhdistämisen parametrit:  

• Input layers -> Valitaan kaikki yhdistettävät rasterit. 
• Tallennetaan ja nimetään ”yhdistetty_korkeusmalli”.  

-> Run. 
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Kuva 14. Rasteritasojen yhdistämisen parametrit. 

 

6. Poistetaan tai piilotetaan yksittäiset ladatut geoTIFF-kuvat. Avataan tason välilehti ja toistetaan kaikille 
prosessi yhdistämättömille kuville. -> Delete layer.  
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QGIS- tukeman vektoritiedoston tuominen 
Mikäli hulevesiverkosto on QGIS:n tukema vektoritiedosto toimitaan tämän otsikon alaisilla ohjeilla. Mikäli 
aineisto on tekninen piirustus, tämä kohta ohitetaan. 

1. Haetaan hulevesiverkoston vektoriaineisto. Valitaan vektoritiedosto ja tiputetaan se työtilaan.  

2. Tarkistetaan sijainti. World. 

Teknisen piirustuksen tuominen .DWG ja .DFX  
Mikäli hulevesiverkosto on tekninen piirustus, toimitaan tämän alaotsikon ohjeiden mukaisesti. Mikäli 
hulevesiverkosto on valmiiksi QGIS:n tukema vektoritiedosto tämä kohta ohitetaan. Tekninen piirustus 
pitää tuoda ja muuntaa QGIS:sa luettavaksi tiedostomuodoksi. Hulevesiverkosto tarvitaan polttotasoa 
varten. 

1. Tuodaan tekninen piirustus työtilaan. Project -> Import/Export -> Import layers from DWG/DFX. 

2. Valitaan teknisen piirroksen parametrit.  

• Target package -> Tallennetaan ja nimetään tunnistettavalla tavalla. Suositeltu tiedostomuoto on 
geopackage. 

• Select CRS -> Valitaan teknisessä piirroksessa käytetty koordinaattijärjestelmä. Tieto selviää 
piirroksen mukana saaduista metatiedoista tai vastaavasta tietolähteestä, kuten kaavan piirtäjältä 
kysymällä. (Tyypillisesti käytetään kunnallista EUREF-FIN koordinaattijärjestelmää).  

• Source Drawing -> Alkuperäinen tekninen piirustus.  

Saadessasi viestin Drawing import failed () aineisto ei ole yhteensopivaa QGIS:n kanssa. Aineistoa on 
muokattava muussa ohjelmistossa luettavaksi.  

 
Kuva 15. Virheviesti teknisen piirustuksen tuomisessa. 

QGIS aloittaa välittömästi tuomaan aineistoa. Riippuen aineiston laajuudesta, sen tuomisessa voi kestää.  
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Kuva 16. Teknisen piirroksen tuomisasetukset 

4. Nimetään ryhmä.  -> Group name. -> Ok. 

5. Tarkistetaan sijainti vertaamalla aineistoa ”yhdistetty_korkeusmalli” tasoon.  

6. Tarkistetaan aineisto. Tarpeellisia kohteita ovat viivamuotoiset putket, rummut ja avo-ojat. 
Viivamuotoiset vakavedet, kuten järvet, altaat meri ja lammet eivät ole välttämättömiä ja ne voidaan 
poistaa harkinnanvaraisesti. Pistekohteet, kuten kaivot eivät ole tarpeellisia. 

Mikäli tuodussa tiedostossa on saman tason sisällä ylimääräisiä kohteita, kuten tieviivoja, rakenteita tai 
tontin rajoja, tulee ne poistaa. Voidaan tehdä aineiston tarjoajalle uusi aineistopyyntö, tai toimia 
kohdan 7. mukaisesti.   
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Kuva 17. Vain vihreät (hulevesiputket) ja siniset (avo-ojat) ovat tarvittavaa tietoa. Muut tiedot on poistettava tai piilotettava. 

7. Tämä kohta ohitetaan, mikäli ylimääräistä tietoa ei ole hulevesiverkostossa. Avataan tason 
attribuuttitaulukko. Attribuuttitaulukon ominaisuustietojen avulla maalataan ne kohteet, jotka halutaan 
erottaa omaksi tasokseen. Avataan tason välilehti. Attribute table -> Valitaan kohteet -> Avataan tason 
välilehti -> Export selected -> Save as. Tallennetaan tunnistettavalla tavalla -> OK.  

7b. Tarkistetaan tulos. 
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Polttotason täydentävät aineistot 
Polttotaso koostuu kunnallisesta hulevesiverkostosta ja kansallisista maastotietokannan kohteista. 
Tarvittavat kansalliset Polttotason osat haetaan MML-karttapalvelusta. 

1. Ladataan tarvittavat maastotietokannan kohteet. Tiedostopalvelu -> Lataa avoimia aineistoja -> 
Maastotietokanta -> Kunta -> Hydrografia/Rakennukset (altaat löytyvät rakennusten alta). 

• Kunnista tulee olla valittuna ne kunnat, joiden alueille valuma-alue, tai tutkittava alue ylettyy. 
• Teemoista valittuna tulee olla hydrografia ja rakennukset. 

2. Tiputetaan tiedostot työtilaan ja valitaan tarpeelliset tiedot. -> Add layers. 

 
Kuva 18. Hydrografian mukana tulee tarpeettomia kohteita, joita ei tarvitse tuoda. 

3. Tarkistetaan maastotietokannan kohteet. Mikäli kohteilla ei ole sisältöä, ne voidaan poistaa (sisämaassa 
esimerkiksi meri. 

Polttotason geometrian muuntaminen 
Työtilassa pitäisin olla nyt hulevesiverkko ja maastotietokannan kohteet polttotason muodostamista 
varten. Polttotason geometria on muunnettava WSSP:sa valitun työkalun takia. Tämä toteutetaan 
puskuroimalla kaikkia viivamuotoisia kohteita samanarvoisesti, jotta niistä tulee monikulmioita. 

1. Yhdistetään maastotietokannan ja hulevesiverkoston viivamuotoiset aineistot. Processing-> Processing 
toolbox -> Vector General -> Merge vector layers 

https://asiointi.maanmittauslaitos.fi/karttapaikka/tiedostopalvelu/maastotietokanta
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2. Valitaan parametrit.  

• Input layers -> Valitaan kaikki geometrialtaan viivamaiset kohteet, eli hulevesiverkko ja 
maastotietokannan kapeat virtavedet. 

• Destination CRS [optional] -> muunnetaan kaikki kohteet kansalliseen koordinaattijärjestelmään. 
EPSG:3067, ETRS-TM35FIN.  

• Tallennetaan väliaikaisena. 

 -> Run. 

3. Muunnetaan yhdistetty viivamuotoinen taso puskuroimalla monikulmioksi. Processing-> Processing 
toolbox -> Vector geometry -> Buffer 

4. Valitaan puskuroinnin parametrit: 

• Input layer -> Äskettäin luotu sulatettu viivataso eli ”merged”. 
• Distance -> Puskurointietäisyys. Arvoksi asetetaan 1 metri. 
• Dissolve result ->  
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• Tallennetaan väliaikaisena. 

 -> Run. 

5. Nimetään merged uudelleen. Avataan tason välilehti -> rename layer -> ”merged1”. 

 

Polttotason yhdistäminen 
Puskuroituitu uomatieto Buffered on yhdistettävä monikulmiomuotoisiin maastotietokannan vaka- ja 
virtavesiin.  

1. Yhdistetään puskuroitu taso Buffered ja maastotietokannan monikulmiot yhteiseksi polttotasoksi. 
Processing-> Processing toolbox -> Vector General -> Merge vector layers 
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Kuva 19. Vektoritasojen yhdistäminen. 

2. Valitaan yhdistämisen parametrit: 

• Input layers -> Valitaan puskuroidut viivatasot Buffered. Lisäksi kaikki maastotietokannan 
geometrialtaan monikulmiomuotoiset aineistot kuten altaat, järvet, meret ja virtavesialueet. 

• Tallennetaan väliaikaisena. 

 -> Run. 

Polttotason leikkaaminen 
1. Leikataan merged tasosta valuma-alueen ulkopuolelle jäävät osat. Processing-> Processing toolbox -> 
GDAL-> Vector geoprocessing -> Clip vector by extent 
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Kuva 20. Vektorin leikkaaminen rasterista määritetyillä rajoilla. 

2. Valitaan leikkauksen parametrit: 

• Input layer -> merged 
• Clipping extent -> Calculate from Layer -> yhdistetty_korkeusmalli 
• Tallennetaan ja nimetään ”polttotaso” 

 -> Run. 
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Kuva 21. Leikkaamisen tulos. Vasemmalla leikkaamaton vektori. Oikealla leikattu 

  

Korkeusmallin polttaminen 
Viedään moduulin alussa luotu yhdistetty_korkeusmalli uudeksi tasoksi ja nimetään se uudelleen. Tämä on 
tehtävä sillä työkalu muuten polttaa yhdistetyn korkeusmallin, jolloin sitä ei voi hyödyntää enää WSSP:n 
myöhemmässä vaiheessa. 

1. Avataan tason välilehti ja valitaan Export -> Save as -> Tallennetaan ja nimetään poltettu_korkeusmalli 

-> Run. 

2. Haetaan polttotyökalu. Processing -> Processing Toolbox -> GDAL -> Vector conversion -> Rasterize 
(Overwrite with Fixed Value) 

3. Valitaan polttamisen parametrit: 

• Input vector layer -> polttotaso. 
• Input raster layer -> poltettu_korkeusmalli. 
• A fixed value to burn -> -10. Arvon on oltava negatiivinen ja työtilan yksiköt metrejä! 
• Advanced Parameters -> Add burn in values to existing raster values ->  

 -> Run. 
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Kuva 22. Polttotyökalu ja parametrit. 

3. Tarkistetaan tulos. Polton tulisi näkyä nyt selkeästi poltetussa korkeusmallissa (poltettu_korkeusmalli). 
Tulosta voi selkeyttää hyödyntämällä alempia seuraavan kohdan ohjeita. 



 

30 
 

 
Kuva 23. Poltettu korkeusmalli. Polttotason osoittamat uomat näkyvät selkeästi. 
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Muotoilu ja häivyttäminen 
Tämä kohta voidaan ohittaa, mikäli poltettuja uomia tai korkeusmallia ei tarvitse taittaa, tai rasterin 
tarkastelu ei ole tarpeellista työtilassa. 

1. Selkeytetään rasteria. Min / Max Value Settings -> Cumulative count cut. -> Valitaan arvoiksi 1 ja 99 % -> 
Apply/Ok 

 
Kuva 24. Rasteritason minimi- ja maksimiarvot. 

2. Monistetaan taso. Avataan poltettu_korkeusmalli välilehti -> Duplicate layer.  

3. Muokataan monistetun tason poltettu_korkeusmalli _copy tyyliä. Avataan tason välilehti. Valitaan 
topografiaa parhaiten edustavat värit. Properties -> Symbology-> Singleband pseudocolor -> Color ramp -> 
Topography. 

Tyylejä voi hakea lisää tyylikirjastosta: 



 

32 
 

 
Kuva 25. Tyylikirjasto. 

4. Muokataan “poltettu_korkeusmalli ” tason tyyliä. Avataan tason välilehti. -> Properties -> Symbology-> 
Render type -> Hillshade -> Layer rendering -> Blending mode -> Multiply. -> Apply/ok. 

5. Tasot tulee asettaa allekkain työtilassa (layers panel).  
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Kuva 26. Topografinen karttatyyli, jossa toinen taso luo rinnevarjostuksen. 
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Valuma-alueiden ja uomaverkon määrittäminen r.watershed:lla 
Valuma-alueiden määrityksessä ohjeita täytyy soveltaa, riippuen minkälaista valuma-aluetta määritetään. 
Valuma-alueet luodaan halutussa skaalassa, lähtöaineiston (korkeusmallin hilakoko) ja vedenjakajien 
ehdoilla. Valuma-alueet tallennetaan vapaana tyyppinä. 

• Järven, tai muun vastaavan vakaveden valuma- tai osavaluma-alueen määrityksessä tulee 
hyödyntämää r.watershed tuottamaa valuma-alue- ja uomaverkkotasoja. Tällöin vakavesialueen 
valuma-alue koostuu Unique label for each watershed tasoista, joiden Stream Segments on 
hydrologisessa yhteydessä tarkasteltavaan vesistöön. 

 
Kuva 27. Järven valuma-alue koostuu niiden uomien valuma-alueista, jotka laskevat järveen. (Kuvassa järvi rajattuna punaisella, ja järven 
valuma-alue sinisellä.  
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• Uoman, tai muun vastaavan vesistön valuma-alue, jolla on selkeä purkupiste, määritetään 
hyödyntämällä r.watershed:n  virtaussuuntatasoa (drainage direction) ja r.water.outlet työkalua. 
Tällöin r.water.outlet työkalulle osoitetaan uoman purkupiste, jolloin työkalu laskee osoitetun hilan 
alapuolisen valuma-alueen. 

 
Kuva 28. Uoma määritetään purkupisteestä. (Kuvassa valuma-alue punaisella. Purkupiste sinisellä ympyröitynä) 
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R.watershed 
R.watershed on WSSP:n valuma-alueen määritystyökalu. Työkalu tuottaa virtaussuuntatason, valuma-
alueet ja valuma-alueiden pääuomat käyttäjän määrittämässä skaalassa. 

1. Haetaan valuma-alueen määrityksen työkalu. Processing ->Processing toolbox -> GRASS -> Raster(r*) -> 
r.watershed 

2. Valitaan tasojen muodostamiseen vaadittavat parametrit: 

• Elevation -> poltettu_korkeusmalli  
• Convergence factor for MFD. -> 5. (Tämä arvo määrää, kuinka suuri konvergenssi uomilla on. Arvolla 

1 on suurin eriytyminen, mikä muodostaa eniten uomia, arvolla 10 taasen päinvastoin). 
• Minimum size of exterior watershed basin -> 20000. Parametrilla valitaan pienin mahdollinen koko 

valuma-alueille. Arvo on pakollinen. Pienemmät arvot vaativat enemmän laskuaikaa sekä ovat 
raskaampia käsitellä, mutta muodostavat pienempiä ja tarkempia valuma-alueita. 

• Arvo määrittää Unique label for each watershed basin rasterin koon ja tarkkuuden. 
• Arvo määrittää Stream segments rasterin tarkkuuden 

3. Valitaan ne laskutulokset, jotka ovat tarpeellisia: 

• Drainage direction -> Tallennetaan ja nimetään tunnistettavalla tavalla. 
• Unique label for each watershed basin ->Tallennetaan ja nimetään tunnistettavalla tavalla. 
• Stream segments Tallennetaan ja nimetään tunnistettavalla tavalla. 
• Muihin kohtiin -> Skip output. Valinnalla ohitetaan muut laskutulokset. 

 -> Run. 

4. Tarkistetaan tulos, sulkematta työkalua (Kuvassa 31. esimerkkejä) 

• Unique label for each watershed basin taso osoittaa minimiarvojen mukaiset valuma-alueet.  
• Stream segments taso osoittaa laskettujen valuma-alueiden uomien sijainnit.  
• Drainage direction taso osoittaa virtaussuunnan. Tasoa tarvitaan r.water outlet työkalussa. 
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Kuva 29. R.watershed parametrit. 
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Kuva 30. R.wateshed tarvittavat laskutulokset. 
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Kuva 31. Laskutulokset. Vasemmalla harmaan sävyisenä Drainage direction ja päällä väreillä Stream segments. Oikealla  Unique label for each 
watershed basin. 

 

R.watershed  laskenta-alueen rajaus 
Työkalun laskualuetta voidaan rajata. Tämä helpottaa tarkasteltavan alueen pilkkomista osavaluma-
alueiksi. 

1. Toimitaan tismalleen samoin kuin kohdassa R.watershed lukuun ottamatta seuraavia vaiheita: 

2. Minimum size of exterior watershed basin -arvoa tulee säätää ehdotettua pienemmäksi, riippuen 
tarkasteltavan alueen koosta. Arvot voivat olla esimerkiksi 2000 tai 5000.  

3. Rajataan alue pienemmäksi kartalla. Advanced parameters -> Grass Gis 7 region extent -> Draw on 
canvas. 

Alue voidaan esimerkiksi piirtää hyödyntäen aiemmin luotua Unique label for each watershed basin tason 
ulkorajoja noudatellen. 

 
Kuva 32. Grass GIS rajaustoiminto. 
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Kuva 33. Eräs alue uomaverkkoineen. Valuma-alue on piirretty määritetty r.watershed laskutulosta ja r.water.outlet:a hyödyntäen. ( Minimum 
size of exterior watershed basin 20000) 

 
Kuva 34. Sama valuma-alue rajattuna ja laskettuna eri minimikoolla. (Minimum size of exterior watershed basin 2000) 
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Kuva 35. Sama valuma-alue rajattuna ja laskettuna. (Minimum size of exterior watershed basin 5000) 
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R.water.outlet 
R.watershed tuottaa drainage direction rasteritason, josta voidaan muodostaa tietyn hilan yläpuolinen 
valuma-alue r.water.outlet:lla. Työkalu on hyödyllinen tarkastellessa vesistöjä, joilla on selkeä purkupiste. 

1. Toimiakseen r.water.outlet vaatii r.watershed:n tuottaman drainage direction tason. Tämä tuotetaan 
aiemmin ohjeistetulla tavalla. 

2. Järjestetään tasot työtilassa. Tavoitteena on, että uomien sijainnit löytyvät. Drainage direction ja 
polttotaso voivat olla tässä apuna. Myös stream segments ja poltettu_korkeusmalli voivat auttaa. 

 
Kuva 36. Esimerkki järjestyksestä. 

3. Luodaan ryhmä tasoikkunaan ja nimetään ryhmä tunnistettavalla tavalla. Maalataan ryhmä. (Tällä tapaa 
maalaamalla ryhmän, voidaan kaikki tasot asettaa automaattisesti ryhmän sisälle, kun käytetään mitä 
tahansa työkalua). 

 

4. Haetaan työkalu. Processing -> Processing toolbox -> GRASS -> Raster (r*) -> r.water.outlet 

5. Valitaan r.water outlet parametrit: 

• Name of the input raster map -> “Drainage direction” virtaussuuntarasteri 
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• Coordinates of the outlet point -> Valitse tarkasteltavan uoman purkupiste työtilasta 

 

• Tallennetaan tilapäisenä. 

-> Run. Sulkematta työkalua! 

8. Tarkistetaan tulos. Mikäli tuotettu valuma-alue ”Basin” on vain muutaman hilan kokoinen, on syynä 
todennäköisimmin virtaussuuntatason (drainage direction) kannalta väärä purkupiste (coordinates of 
outlet point). Oikean hilan löytäminen voi vaatia toisinaan useita yrityksiä! Tasoja voi myös järjestellä 
uudelleen, kunnes mieluisa järjestys löydetään. 

8b. Väärät tasot tulee poistaa -> delete layer.  Valitaan uusi purkupiste ja kokeillaan uudelleen, kunnes 
oikea hila löytyy. 

 
Kuva 37. R.water.outlet laskentatulos eräälle uomalle. 

9. Toistetaan prosessia tarpeen mukaan uudelleen. 

 

Valuma-alueiden polygonisointi 
Tämä kohta toteutetaan, mikäli valuma-alueita on tarpeen muuntaa vektoreiksi. Muutoin kohta 
ohitetaan. Valuma-alueet on muutettava vektoreiksi, jotta niille voidaan laskea ominaisuustietoja. 

1.Haetaan polygonisointityökalu ja toteutetaan tarpeen mukaan prosessi erinä. Mikäli polygonisoidaan 
vain yhtä tasoa, vaihetta ei tarvitse toteuttaa erissä. Processing-> Processing toolbox -> GDAL-> Raster 
conversion -> Polygonize -> Execute as Batch process 
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2. Valitaan polygonisoinnin parametrit (erissä). 

• Input layers -> Autofill Select From open layers -> Valitaan kaikki ne tasot, jotka halutaan muuttaa 
vektoreiksi. 

• Band number Autofill -> Käytetään oletusasetusta.  
• Use 8-connectedness -> Autofill -> No. 
• Vectorized. -> Painetaan kolmea pistettä ja etsitään tallennuspaikka -> Voidaan kirjoittaa etuliite 

tiedostonimeen (esim. kunta ”VALU_”, ”OSAVALU_”) -> Autofill -> Autofill settings -> Fill with 
numbers -> ok. 

• Load layers on completion  

-> Run. 

 
Kuva 38. Polygonisoinnin parametrejä. 

3. Yhdistetään tasot, mikäli tarpeellista. Processing-> Processing toolbox -> Vector General -> Merge vector 
layers 
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Kuva 39. Polygonisoinnin tulos. Kuvassa keltaisella rasteritasoja. Oikealla usealla värillä vektoritasot. 

Uomien polygonisointi 
Tämä kohta toteutetaan, mikäli uomia on tarpeen muuntaa vektoreiksi. Muutoin kohta ohitetaan. 
Toisinaan uomia voi olla tarpeellista polygonisoida.  

1. Haetaan työkalu. Processing -> Processing toolbox -> GRASS->Raster(r.*) -> r.to.vect 

2. Valitaan polygonisoinnin parametrit: 

• Input raster layer -> Stream segments. 
• Feature type -> Line. 
• Tallennetaan tunnistettavalla tavalla. 

-> Run. 

2b. Jos työkalu ei tuota vektoritasoa, täytyy ohentaa. Processing -> Processing toolbox -> GRASS-
>Raster(r.*) -> r.thin 

- >Run. 

Palataan ohennetun aineiston kanssa kohtaan 2. 
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Kuva 40. Uomien polygonisonnin parametrit. 

3. Yhdistetään tasot, mikäli tarpeellista. Processing-> Processing toolbox -> Vector General -> Merge vector 
layers 

  



 

48 
 

WSSP Maankäyttöluokka- ja 
muutosaluemoduuli 

 
Kuva 41. Maankäyttö pilottialueella WSSP:n määritelmien mukaan. 
Tiivistelmä 
On suositeltavaa luoda erillinen työtila maankäyttöluokkamoduulia varten. Moduulissa muunnetaan 
lähtöaineisto vastaamaan WSSP maankäyttöluokittelua. Tämän avulla saadaan käsitys hulevesien kannalta 
merkittävien maankäyttömuotojen laajuudesta ja ihmistoiminnan merkityksestä maankäyttömuodoittain. 
Lisäksi luokittelun avulla voidaan paikantaa muutosalueet. Muutosalueet ovat niitä alueita, jotka voivat 
muuttua hydromorfologiselta luonteeltaan niin paljon, ettei niitä voi pitää enää samana 
maankäyttömuotona. Moduulin tavoitteena on: 

• Muuntaa yleiskaava vastaamaan WSSP maankäyttöluokkia (”korjaamaton maankäyttö”) 
• Luoda nykytilaa heijasteleva maankäyttötaso (”korjattu maankäyttö”) 
• Määrittää ”muutosalueet” 
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Moduulissa tarvittavat lähtöaineistot: 

• Yleiskaava 
• Maastotietokannan tarvittavat kohteet 
• LUKEN metsätiedon tarvittavat kohteet 

Jotta maankäyttöluokittelu voidaan tehdä, on muutettava kaavan käyttötarkoitusluokat vastaamaan 
WSSP:n maankäyttöluokkia. Tämä tarkoittaa sitä, että esimerkiksi kaavan käyttötarkoitusta ilmaisevasta 
ominaisuustiedosta kuten V, PY, tulee luokat ”Palvelualueet” sekä ”Vesialueet” jne. 
Käyttötarkoituksettomalle kohteelle annetaan luokka ”Kaavaton” 

Yleiskaavan on oltava topografisesti ehjä ja geometrialtaan monikulmio. Lisäksi jokaisella yleiskaavan 
kohteella tulee olla kaavanmukaista käyttötarkoitusta vastaava ominaisuustieto. Mikäli aineisto ei täytä 
näitä ehtoja, tarkoittaa tämä lisätyötä. Topografiset virheet tulee korjata, jotka ohjeistetaan. 
Viivamuotoinen geometria vaatii polygonisoinnin. Ilman ominaisuustietoa maankäyttöluokittelua ei voi 
tehdä. Polygonisointi ja ominaisuustiedon lisääminen pistetason avulla ohjeistetaan. 

 

QGIS- tukeman vektoritiedoston tuominen 
Mikäli hulevesiverkostoaineisto on QGIS:n tukema vektoritiedosto toimitaan seuraavasti. Mikäli aineisto 
on tekninen piirros, tämä kohta ohitetaan. 

1. Haetaan aineisto. Valitaan vektoritiedosto ja tiputetaan se työtilaan.  

2. Tarkistetaan sijainti World-komennolla. Coordinates -> World. 

3. Tarkistetaan ominaisuustiedot ja -muoto. Avataan tason välilehti. -> Attribute table. 

Tuodun tiedoston on sisällettävä jokin ominaisuustieto, josta kaavan käyttötarkoitusta vastaava tieto käy 
ilmi. Tämä voi olla lyhenne (W, AS, V, PA) tai mikä tahansa muu käyttötarkoitusta vastaava tieto. 
Yleiskaavan tulee olla topografisesti ehjä monikulmio. Topografinen korjaus esitellään ohjeissa. 

Teknisen piirustuksen tuominen .DWG ja .DFX  
Tekninen piirustus pitää tuoda ja muuntaa QGIS:issa luettavaksi tiedostomuodoksi. Mikäli aineisto on 
QGIS:n tukema vektoritiedosto, tämä kohta ohitetaan. Mikäli kaavan tekninen piirustus saadaan 
viivamuotoisena, eikä se sisällä tarpeellista ominaisuustietoa, se tulee muuntaa monikulmiomuotoon. 

1. Tuodaan tekninen piirustus työtilaan. Project -> Import/Export -> Import layers from DWG/DFX. 

2. Valitaan tuomisen parametrit: 

• Target package -> Tallennetaan ja nimetään tunnistettavalla tavalla. Suositeltu tiedostomuoto on 
geopackage (GPKG). 

• Select CRS -> Valitaan teknisessä piirroksessa käytetty koordinaattijärjestelmä. Tieto selviää 
piirustuksen mukana saaduista metatiedoista tai vastaavasta tietolähteestä, kuten kaavan 
piirtäjältä kysymällä. (Tyypillisesti käytetään kunnallista EUREF-FIN koordinaattijärjestelmää).  

• Source Drawing -> Alkuperäinen tekninen piirustus.  

3. Nimetään ryhmä.  -> Group name. -> Ok. 

4. Tarkistetaan sijainti. Coordinates -> World. 



 

50 
 

5. Tarkistetaan tuodun aineiston muoto ja ominaisuustiedot. Attribuuttitaulukosta pitää löytyä kaavan 
käyttötarkoitusta vastaava tieto jokaiselle kohteelle. 

6. Piilotetaan tai poistetaan tarpeettomat tasot. Tarpeellisia tasoja ovat monikulmiomuotoinen yleiskaava 
ja mahdollisesti kaavan käyttötarkoitusta ilmaiseva pistetaso. 

 

Pirstaleisen viivamuotoisen geometrian muuntaminen monikulmioksi 
Tämä kohta ohitetaan, mikäli aineisto on yhtenäinen monikulmio valmiiksi. Tässä osiossa opastetaan, 
kuinka aineisto korjataan käyttökelpoiseksi silloin, kun se tuodaan ohjelmaan viivamuotoisena ja 
sirpaleisena. 

1. Haetaan geometrioiden yhdistämisen työkalu Processing -> Processing toolbox -> Vector Geometry -> 
Snap Geometries to a layer. 

2. Valitaan geometrian yhdistämisen parametrit: 

• Tolerance (1)  
• Behaviour -> Snap to anchor nodes 
• Tallennetaan välikaisena. 

-> Run. 

3. Muodostetaan luodusta vektorista monikulmio. Processing -> Processing toolbox -> Vector Geometry -> 
Polygonize.  

4. Valitaan polygonisoinnin parametrit: 

• Input layer -> Snapped Geometries 
• Tallennetaan tunnistettavalla tavalla. 

-> Run. 
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Kuva 42. Viivamuotoisen geometrian muuntaminen monikulmioksi. 

5. Tarkistetaan tulos vertaamalla viiva- ja monikulmiomuotoista vektoritasoa. Korjataan mahdolliset 
virheet käsin digitoimalla. Snap Geometries to a layer, Tolerance -arvoa voidaan koittaa säätää käsitöiden 
välttämiseksi. Pilotoinnissa huomattiin, että yhtä metriä suuremmat arvot voivat muuttaa kaavaa 
olennaisella tavalla! 
 

Kaavan käyttötarkoitusta vastaavan tiedon liittäminen monikulmioon sijainnin avulla 
Tämä kohta ohitetaan, mikäli aineistossa on kaavan käyttötarkoitusta vastaava ominaisuustieto. 
Monikulmioon voidaan liittää sijannin avulla ominaisuustieto. 

1.Haetaan sijainnin perusteella liittämisen työkalu. Processing Toolbox ->  Vector general -> Join attributes 
by location  

2. Valitaan sijainnin perusteella liittämisen parametrit: 

• Base layer -> (edellisessä vaiheessa luotu taso) Taso josta puuttuu kaavan käyttötarkoitusta 
vastaava ominaisuustieto 

• Join layer -> Taso joka sisältää kaavan käyttötarkoituksen (pistemuotoinen) 
• Geometric predicate -> Contains 
• Fields to add -> Valitaan se ominaisuustieto, joka sisältää kaavan käyttötarkoituksen 
• Join type -> Take attributes of the first matching feature only (one-to-one) 
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• Joined layer -> Tallennetaan taso tunnistettavalla tavalla. 

-> Run. 

 
Kuva 43. Sijainnin perusteella ominaisuustietojen liittämisen parametrit. 

Menetelmä on ainoastaan, niin tarkka kuin lähtöaineisto ilman korjaamista ja tarkistamista. On 
mahdollista, että alueet sisältävät useita pisteitä tai pisteet eivät osu monikulmioihin. Lisäksi on 
mahdollista, että väärä piste osuu kohteeseen. Tästä seuraa epätarkkuuksia, jotka joudutaan korjaamaan 
käsin attribuuttitaulukkoa ja pistetasoa vertaamalla. Rinnakainen kuvatarkastelu voi myös auttaa 
korjauksessa. 
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Kuva 44. Attribuuttitaulukon voi kiinnittää työtilaan. 
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Kuva 45. Tason attiribuuttitaulukko. NULL-arvot ovat niitä arvoja, joiden kohteiden sisällä ei ollut pistettä, joka ilmaisisi käyttötarkoitusta. 

 
Kuva 46. Vasemmalla tilanne, jossa useita pisteitä osuu saman kohteen sisälle. Oikealla pistetaso ei osu kohteen sisälle. Kaikki tämä tuottaa 
virhettä. 
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Projektointi 
 

Ennen korjauksen aloittamista kaava tulee projektoida uudelleen EPSG:3067, ETRS-TM35FIN järjestelmään. 
Vaihtoehtoisesti kaikki ne aineistot, joita liitetään, tulee projektoida kunnalliseen koordinaatistoon. 

1.Haetaan projektointityökalu -> Vector general -> Reproject Layer  

2. Valitaan projektoinnin parametrit: 

• Input layer -> Yleiskaava (Uudelleen projektoitava taso). 
• Target CRS -> EPSG:3067, ETRS-TM35FIN. 
• Tallennetaan väliaikaisena. 

-> Run.  

 
Kuva 47. Uudelleen projektoinnin parametrit. 
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Yleiskaavan topologisten virheiden korjaus 
Kaikista HULVATTU pilottikunnista hankitut lähtöaineistot (yleiskaavat) sisälsivät topologisia virheitä. 
Yleiskaavojen teknisissä piirroksissa oli limittäisyyksiä ja reikiä sekä geometrioiden hukkapaloja.  

Aineiston virheet voidaan hyväksyä, tai ne voidaan korjata. Topologinen eheyttäminen vie aikaa. Mikäli 
aikaa ei ole täydelliseen korjaukseen, on suositeltavaa korjata vähintään suurimmat virheet, kuten 
kokonaisten kohteiden päällekkäisyydet ja suuret reiät.  

• Geometrian hukkapalat (Dangles) voivat aiheuttaa virheitä liitettäessä kohteita toisiinsa yhteisen 
rajan perusteella. 

• Limittäisyydet (Overlaps) edustavat virheellistä tietoa. 
• Reiät (Gaps) edustavat puutteellista dataa. 

Topologisten virheiden korjaamiseen ja paikantamiseen on kolme valmista työkalua: 

• Topology checker plugin - Automaattiset tarkistukset, mutta käsin korjaukset 
• Geometry Checker plugin - Automaattinen tarkistukset, mutta puoliautomaattiset korjaukset 
• V.clean - Automaattiset tarkistukset ja korjaukset GRASS:in avulla 

Yksikään työkalu ei osoittautunut pilotoinnissa aukottomaksi. Käsin korjaamisessa hyödynnettiin 
digitointia, fix geometries-, ja remove dangles- työkaluja. Reiät täytettiin buffer-, dissolve-, difference, -
työkaluja hyödyntäen. V.clean toimii heikosti, tai ei ollenkaan QGIS 3.27 versiossa. Tästä syystä työkalua ei 
suositella käytettäväksi. GRASS GIS ohjelmalla työkalu toimii paremmin. 

Kaikkia virheitä ei todennäköisesti saada poistettua. Vähin mitä täytyy tehdä, on suurimpien reikien 
täyttäminen. 

Topologinen tarkistus 
Topologinen tarkistus voidaan tehdä nopeasti. Mikäli virheitä on vähän, koko topografisen eheyttämisen 
voi ohittaa. Huomionarvoista on, että Geometry Checker plugin voi antaa eriäviä tuloksia. 

1. Valitaan työkaluriviltä: Vector -> Topology Checker plugin 

2. Valitaan topologisen tarkistuksen parametrit, lisäämällä tason seuraavat säännöt: 

• Must not have duplicates 
• Must not have gaps  
• Must not have invalid geometries 
• Must not overlap 

3. Painetaan Ok -> Validate all. 
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Kuva 48. Topologisen tarkistuksen validointi. 
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Kuva 49. Topologisen tarkistuksen säännöt 
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Kuva 50. Topologisen tarkistuksen tulokset. Kuvassa violetilla kaava. Punaisella virheet. Ruskealla valuma-alue. 

 

Pilotoinnissa virheiden laajuus vaihteli neliösenteistä-kilometreihin, ja määrä sadoista virheettömään. 
Lisäksi on huomionarvoista, että Topographic checker ei kykene paikantamaan niitä kohtia, jotka ovat 
”auki” reunoista (valkoiset halkovat muodot kuvassa 49). Nämä kuitenkin edustavat puuttuvaa dataa, joten 
nekin on täytettävä. 

3. Tarkistetaan reikien sijainti sulattamalla ja luodaan seuraavaa vaihetta varten työtaso. Processing 
toolbox -> Vector Geometry -> Dissolve  

-> Run. 



 

60 
 

 
Kuva 51. Sulatustyökalun tulos. Reiät näkyvät selkeästi valkoisena, tai mustana viivana. 

 

 

 

Reikien paikkaus ja aineiston leikkaaminen 
Reikiä voi paikata digitoimalla tai toisella vektoritasolla. Kaikkien liitettävien aineistojen tulee olla samassa 
koordinaattijärjestelmässä. 

Yksinkertaisin tapa korjata reikiä on puskuroida aineistoa positiivisella ja negatiivisella arvolla. Tämän 
jälkeen puskuroitu aineisto liitetään ja puskuroimattomaan. Puskurointi aiheuttaa vääristymiä. 
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1. Haetaan puskurointityökalu. Processing-> Processing toolbox -> Vector geometry -> Buffer 

2. Valitaan puskuroinnin parametrit: 

• Input layer -> Dissolved 
• Distance -> 50 (Metrimäärän tulee olla riittävä, jotta suurin osa rei’istä täyttyy ja avoimet päät 

umpeutuvat. Liian suuri puskuri aiheuttaa suuria vääristymiä). 
• Segments -> 5 (vähintään) 
• End cap style -> Flat 
• Join style -> Miter 
• Dissolve result ->  
• Tallennetaan väliaikaisena. 

-> Run. 

 
Kuva 52. Puskuroinnin parametrit. 

3 Toistetaan prosessi puskuroidulle (buffered) tasolle, mutta käytetään negatiivista puskuria. 

4. Valitaan puskuroinnin parametrit: 
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• Input layer -> Buffered 
• Distance -> - 50 (Metrimäärän tulee olla sama kuin aiemmassa vaiheessa, mutta negatiivinen!) 
• Segments -> (Vähintään viisi) 
• End cap style -> Flat 
• Join style -> Miter 
• Dissolve result ->  
• Tallennetaan väliaikaisena.  

-> Run. Tarkistetaan ja nimetään tulos uudelleen. Avataan tason välilehti -> Rename layer -> ”buffered2” 

Menetelmä aiheuttaa ulkoreunojen vääristymää. Pilotoinnissa tämä vääristymä vaihteli senteistä 
muutamaan metriin. 

 
Kuva 53. Puskuroitu taso. 

5. Poistetaan buffered2 -tasosta reiät automaattisesti. Processing toolbox-> vector-geometry -> delete holes 
-> remove holes with area less than -> 0  
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Kuva 54. Reikien poiston parametrit. 

 

6. Etsitään puskuroidun ja puskuroimattoman tason väliset erot, liittämistä varten. Processing-> Processing 
toolbox -> Vector overlay -> Difference 

7. Valitaan erotuksen parametrit: 

• Input layer -> buffered2 (puskuroitu ja täytetty taso) 
• Overlay -> Dissolved   
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Kuva 55. Erotustyökalun parametrit. 
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Kuva 56. Erotuksen tulos. 

 

8. Liitetään erotus (uudelleen projektoituun) kaavaan. Processing-> Processing toolbox -> Vector General -> 
Merge vector layers 

9. Valitaan liittämisen parametrit: 

• Input layers -> Reprojected ja Difference (uudelleen projektoitu kaava ja erotus). 
• Tallennetaan väliaikaisena.  

-> Run. 

10. Kopioidaan ja liitetään luotuun ”merged” tasoon yleiskaavan tyyli. Avataan yleiskaavatason välilehti. 
Styles -> Copy Style -> All categories. 

11. Liitetään tyylit. Avataan merged tason välilehti Styles -> Paste Style -> All categories.  



 

66 
 

 
Kuva 57. Tyylin liittäminen. 
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. 

 
Kuva 58. Reikien täytön tulos. 

12. Viedään luotu taso uudeksi tasoksi. Avataan tason välilehti. Export -> Save as -> 
”maankaytto_tarkistus” -> Select Fields to export and their export options -> “Fid” kenttää ei viedä. 
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Kuva 59. Tallentamisen asetukset. Uniikkia tunnistetta ei viedä. 
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Limittäisyyden poistaminen Check Geometries, ja digitoinnin avulla 
Seuraavaksi poistetaan limittäisyydet. Suoritetaan topologinen tarkistus Check geometries -työkalulla. 
Työkalussa on useita eri parametreja, joista WSSP hyödyntää vain osaa. Työkalu ei osoittautunut parhaaksi 
mahdolliseksi työkaluksi poistaa reikiä. 

1. Valitaan työkaluriviltä: Vector -> Check geometries. 

 
Kuva 60. Check geometries 

2. Valitaan geometrian tarkistuksen parametrit 

• Input Vector layers -> “maankaytto_tarkistus” 
• Topology Checks -> Check for overlaps smaller than -> 0 
• Output directory -> tunnistettava paikka 
• Output vector layers –> Create new layers -> filename prefix “Check” 

-> Run. 
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Kuva 61. Check Geometries tarkistuksen parametrit. 
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3. Tarkistetaan tulos. Check geometries luo uuden tason, johon korjaukset tulevat. Maalataan kaikki 
virheet, ja valitaan alavalikosta attribuutiksi kaavan käyttötarkoitusta vastaava ominaisuustieto. 

Attribute to use when merging features by attribute value -> kaavan käyttötarkoitusta vastaava tieto  

-> Fix selected errors using default resolution. 

 
Kuva 62. Check geometries korjauksen parametrit. 

 

Useimmat virheet korjaantuvat työkalulla, mutta todennäköisesti virheitä jää aineistoon. Tulosta kannattaa 
verrata alkuperäiseen topografisesti rikkinäiseen tasoon. Suuret virheet tulee korjata käsin digitoimalla, 
kun työkalua on käytetty. Kun aineisto on riittävän ehjää, siirrytään seuraavaan vaiheeseen.  

4. Tallennetaan topologisesti ehjä tiedosto. Avataan ”Check” tason välilehti. Export -> Save as. Tallennetaan 
nimellä ”korjaamaton_maankäyttö” -> Ok. 

 5. Ajetaan fix geometries samalle tasolle hakuikkunan kautta. -> Fix geometries 

 (edit selected features) 

6. Tarkistetaan ID. Uniikki tunniste ei saa sisältää ”autogenerate ” arvoja. Muutetaan arvot käsin, tai 
viedään uudeksi tiedostoksi ilman ”fid” arvoa.
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Maankäyttöluokittelu  
Maankäyttöluokittelun voi tehdä joko QGIS:sa tai taulukointiohjelmassa. WSSP:sa maankäyttöluokka on 
jaettu yhteensä 12 eri maankäyttömuotoon. Maankäyttöluokan tarkemmat määritelmät sekä selitteet 
löytyvät WSSP tietokannasta. Maankäyttömuotoja ovat: 

Keskustatoimintojen alueet 

Työ- ja teollisuusalueet 

Palvelualueet 

Kenttäalueet  

Liikennealueet 

Väljät asuinalueet 

Tiiviit asuinalueet 

Maatalousalueet 

Avoimet viheralueet 

Metsäalueet 

Vesialueet 

Erityisalueet 
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Maankäyttöluokittelu QGIS:n avulla 
1. Avataan kenttälaskin ja luodaan uusi ominaisuustieto ”korjaamattomalle maankäytölle”. Avataan 
”korjaamaton_maankäyttö” välilehti ja valitaan Open attribute table -> Edit -> field calculator. 

2. Valitaan uuden kentän parametrit: 

• Create a new field -> 
• Output field name -> mluokka 
• Output field type -> Text 
• Length -> 30 

 
Kuva 63. Kenttälaskin ja maankäyttöluokittelun parametrit. 

3. Tuotetaan kaavan käyttötarkoitusta vastaavasta ominaisuustiedosta lausekkeen avulla WSSP 
maankäyttöluokat. Muokkaamalla seuraavaa lauseketta päästään tavoiteltuun tulokseen: 

CASE 

WHEN "kaavan käyttötarkoitusta vastaava kenttä"  = 'kaavan käyttötarkoitusta vastaava ominaisuustieto' 
THEN 'WSSP maankäyttömuoto' 
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END 

Lausekkeen keltaiset osat ovat muokattavia kohtia. CASE aloittaa ja END lopettaa lausekkeen.  

Esimerkki lausekkeesta jossa ”text” on kaavan käyttötarkoitusta vastaava sarake, jolloin lyhenteen 
avulla saadaan luotua maankäyttöluokat: 

CASE 

WHEN "text"  = 'AK' THEN 'Tiiviit asuinalueet' 

WHEN "text"  = 'AP' THEN 'Väljät asuinalueet' 

WHEN "text"  = 'AT' THEN 'Väljät asuinalueet' 

WHEN "text"  = 'C' THEN 'Keskustatoimintojen alueet' 

WHEN "text"  = 'KM' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'P' THEN 'Palvelualueet' 

WHEN "text"  = 'V' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'W' THEN 'Vesialueet' 

WHEN "text"  = 'PY' THEN 'Palvelualueet' 

WHEN "text"  = 'PL' THEN 'Palvelualueet' 

WHEN "text"  = 'TP' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'T' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'TT' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'TV' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'TY' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'T/kem' THEN 'Erityisalueet' 

WHEN "text"  = 'VL' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'VU' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'VL' THEN 'Metsäalueet' 

WHEN "text"  = 'R' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RA' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RM' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RL' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RV' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RP' THEN 'Maatalousalueet' 

WHEN "text"  = 'L' THEN 'Liikennealueet' 

WHEN "text"  = 'LT' THEN 'Liikennealueet' 

WHEN "text"  = 'LHA' THEN 'Liikennealueet' 

WHEN "text"  = 'LTA' THEN 'Liikennealueet' 

WHEN "text"  = 'L' THEN 'Liikennealueet' 

WHEN "text"  = 'LH' THEN 'Palvelualueet' 

WHEN "text"  = 'LR' THEN 'Liikennealueet' 

WHEN "text"  = 'LL' THEN 'Erityisalueet' 
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WHEN "text"  = 'E' THEN 'Erityisalueet' 

WHEN "text"  = 'LS' THEN 'Erityisalueet' 

WHEN "text"  = 'ET' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'EN' THEN 'Erityisalueet' 

WHEN "text"  = 'EJ' THEN 'Erityisalueet' 

WHEN "text"  = 'EO' THEN 'Erityisalueet' 

WHEN "text"  = 'EK' THEN 'Erityisalueet' 

WHEN "text"  = 'EA' THEN 'Erityisalueet' 

WHEN "text"  = 'EP' THEN 'Erityisalueet' 

WHEN "text"  = 'EH' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'EV' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'S' THEN 'Tarkistettava' 

WHEN "text"  = 'SL' THEN 'Tarkistettava' 

WHEN "text"  = 'SM' THEN 'Tarkistettava' 

WHEN "text"  = 'SR' THEN 'Tarkistettava' 

WHEN "text"  = 'SRS' THEN 'Tarkistettava' 

WHEN "text"  = 'M' THEN 'Tarkistettava' 

WHEN "text"  = 'MT' THEN 'Maatalousalueet' 

WHEN "text"  = 'ME' THEN 'Maatalousalueet' 

WHEN "text"  = 'MA' THEN 'Maatalousalueet' 

WHEN "text"  = 'MY' THEN 'Tarkistettava' 

WHEN "text"  = 'MU' THEN 'Tarkistettava' 

WHEN "text"  = 'W' THEN 'Tarkistettava' 

WHEN "text"  = 'AK/s' THEN 'Tiiviit asuinalueet' 

WHEN "text"  = 'AP/s' THEN 'Väljät asuinalueet' 

WHEN "text"  = 'AT/s' THEN 'Väljät asuinalueet' 

WHEN "text"  = 'C/s' THEN 'Keskustatoimintojen alueet' 

WHEN "text"  = 'KM/s' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'P/s' THEN 'Palvelualueet' 

WHEN "text"  = 'V/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'W/s' THEN 'Vesialueet' 

WHEN "text"  = 'PY/s' THEN 'Palvelualueet' 

WHEN "text"  = 'PL/s' THEN 'Palvelualueet' 

WHEN "text"  = 'TP/s' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'T/s' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'TT/s' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'TV/s' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'TY/s' THEN 'Työ- ja teollisuusalueet' 

WHEN "text"  = 'T/kem/s' THEN 'Erityisalueet' 
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WHEN "text"  = 'VL/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'VU/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'VL/s' THEN 'Metsäalueet' 

WHEN "text"  = 'R/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RA/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RM/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RL/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RV/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'RP/s' THEN 'Maatalousalueet' 

WHEN "text"  = 'L' THEN 'Liikennealueet' 

WHEN "text"  = 'LT/s' THEN 'Liikennealueet' 

WHEN "text"  = 'LHA/s' THEN 'Liikennealueet' 

WHEN "text"  = 'LTA/s' THEN 'Liikennealueet' 

WHEN "text"  = 'L/s' THEN 'Liikennealueet' 

WHEN "text"  = 'LH/s' THEN 'Palvelualueet' 

WHEN "text"  = 'LR/s' THEN 'Liikennealueet' 

WHEN "text"  = 'LL/s' THEN 'Erityisalueet' 

WHEN "text"  = 'E/s' THEN 'Erityisalueet' 

WHEN "text"  = 'LS/s' THEN 'Erityisalueet' 

WHEN "text"  = 'ET/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'EN/s' THEN 'Erityisalueet' 

WHEN "text"  = 'EJ/s' THEN 'Erityisalueet' 

WHEN "text"  = 'EO/s' THEN 'Erityisalueet' 

WHEN "text"  = 'EK/s' THEN 'Erityisalueet' 

WHEN "text"  = 'EA/s' THEN 'Erityisalueet' 

WHEN "text"  = 'EP/s' THEN 'Erityisalueet' 

WHEN "text"  = 'EH/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'EV/s' THEN 'Avoimet viheralueet' 

WHEN "text"  = 'S/s' THEN 'Tarkistettava' 

WHEN "text"  = 'SL/s' THEN 'Tarkistettava' 

WHEN "text"  = 'SM/s' THEN 'Tarkistettava' 

WHEN "text"  = 'SR/s' THEN 'Tarkistettava' 

WHEN "text"  = 'SRS/s' THEN 'Tarkistettava' 

WHEN "text"  = 'M/s' THEN 'Tarkistettava' 

WHEN "text"  = 'MT/s' THEN 'Maatalousalueet' 

WHEN "text"  = 'ME/s' THEN 'Maatalousalueet' 

WHEN "text"  = 'MA/s' THEN 'Maatalousalueet' 

WHEN "text"  = 'MY/s' THEN 'Tarkistettava' 

WHEN "text"  = 'MU/s' THEN 'Tarkistettava' 
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END 

Ylempi lauseke voidaan kopioida suoraan laskentaikkunaan. Lausekkeen arvo ”tarkastettava” on 
väliaikainen arvo, sillä kaavan käyttötarkoituksesta ei saada suoraan WSSP-maankäyttömuotoa. Esimerkiksi 
kaavamerkintä ”M” eli maa- ja metsätalousvaltainen alue, voi olla WSSP-luokituksessa joko ”Metsäalueet”, 
tai ”Maatalousalueet”. 

-> Ok 

3. Tarkistetaan tulos. Mikäli tyhjiä arvoja (Null) löytyy, on lauseketta tai attribuuttitaulukkoa käsin 
muokattava vastamaan WSSP-maankäyttömuotoja. 

 

Maankäyttöluokittelu taulukointiohjelman avulla 
Tämä kohta ohitetaan, mikäli luokittelu tehtiin aiempien ohjeiden mukaan QGIS:sa. Pilotoinnissa 
hyödynnettiin MS-Excel taulukointiohjelmaa. Maankäyttöluokittelun voi tehdä myös muulla 
taulukointiohjelmalla. Luokittelun voi toteuttaa joko QGIS:sa, tai vaihtoehtoisesti missä tahansa CSV:ta 
tukevassa taulukointiohjelmassa.  

1. Muunnetaan vektoritiedosto taulukointiohjelmassa luettavaan muotoon. Avataan tason välilehti ja 
valitaan Export -> Save as. Valitaan tallenteen ominaisuudet. Format Ms Office XML Spreadsheet [XLSX] tai 
Comma separated Value [CSV] 
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Kuva 64. Vektorin muuntaminen taulukoksi. 

3. Selkokielistetään luokat taulukointiohjelmassa. Mitään arvoja ei saa poistaa. Luodaan 
maankäyttöluokille oma nimetty sarake ”mluokka” johon kirjataan WSSP-maankäyttöluokat. 

4. Kun maankäyttöluokittelu on tehty, taulukko suljetaan ja tiputetaan työtilaan. 

5. Liitetään taulukko ja korjaamaton_maankäyttö yhteen uniikin tunnisteen avulla. (Tyypillisesti “ID” tai 
“fid” ) Processing -> Toolbox -> Vector general -> Join attributes by field value. 
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6. Valitaan attribuuttien liittämisen parametrit: 

• Input layer -> ”korjaamaton_maankäyttö” 
• Table field  -> Fid.  (uniikki tunniste) 
• Input layer 2 -> Maankäyttöluokiteltu taulukko 
• Table field 2 -> Fid. (uniikki tunniste) 
• Layer 2 fields to copy -> “mluokka” -> ok. 
• Tallennetaan tunnistettavalla nimellä. 

-> Run. 

 
Kuva 65. Taulukon ja vektorin yhteen liittäminen uniikin tunnisteen avulla. 
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Kuva 66. Liitettävät kentät. Ainoastaan maankäyttöä edustava " mluokka" tarvitaan taulukosta. 

7. Tarkistetaan tulos. . Mikäli tyhjiä arvoja (Null) löytyy, ne on täytettävä. 

Täydentäminen Maanmittauslaitoksen aineistoilla 
Jotta maankäytöstä saadaan nykytilaa edustava, on sitä täydennettävä. 

1. Tarvittavat osat haetaan MML-karttapalvelusta. Näitä kohteita ovat muun muassa: Niitty (32800), Puisto 
(32900), Urheilu- ja virkistysalue (33100), Virtavesialue (36313) 32400, Pelto (32611) Puutarha (32612), 
Allas (44300) Merivesi (36211) ja Järvivesi (36212). Maastotietokannan kohteet muutetaan myöhemmin 
vastaamaan WSSP-maankäyttöluokittelua. 

2. Tiputetaan aineisto työtilaan. Leikataan aineisto ja toteutetaan prosessi osissa. Processing-> Processing 
toolbox-> Vector overlay-> Clip -> Execute as Batch process Ennen leikkausta, on tarkistettava, että 
geometriat on korjattu tasolle (fix geometries, sille tasolle jolla leikataan) ja että 
koordinaattijärjestelmät ovat kaikilla tasoilla samat.  

 

3. Valitaan leikkauksen parametrit 

• Input layers -> Maastotietokannan kohteet 
• Overlay layer -> “korjaamaton_maankäyttö”  

https://asiointi.maanmittauslaitos.fi/karttapaikka/tiedostopalvelu/maastotietokanta
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• Clipped -> Painetaan kolmea pistettä ja etsitään tallennuspaikka -> Voidaan kirjoittaa etuliite 
tiedostonimeen (esim. kunta ”OULU_”, KUUSAMO_”) -> Autofill mode-> Fill with parameter values -
> Parameter to use -> Input layer -> Ok 

• Load layers on completion ->  

 -> Run. 

 
Kuva 67. Lisäämällä etuliitteen, tiedostonimet ovat helpommin erotettavissa. 

 

 
Kuva 68. Maastotietokannan leikkaaminen erissä. 

4. Yhdistetään kaikki leikatut maastotietokannan kohteet. Processing-> Processing toolbox -> Vector 
General -> Merge vector layers 

• Tallennetaan väliaikaisena. 
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5. Lasketaan maastotietokannan kohteiden pinta-alat liian pienten kohteiden poistoa varten. Avataan juuri 
äsken luodun ”merged” tason välilehti -> Calculate geometry  

6. Poistetaan kaikki alle 0,5 HA kohteet. Avataan tason attribuuttitaulukko ja kytketään muokkaus päälle. 
Järjestetään ”area” -sarake alimmasta suurimpaan. Maalataan kaikki alle 5000 m² kohteet ja poistetaan ne. 

7. Poistetaan kaikki alle 0,5 HA reiät. Processing-> Processing toolbox-> Vector-geometry -> Delete holes -> 
Remove holes less than -> 5000. 

8. Sulatetaan maastotietokannan kohteet. Processing toolbox -> Vector Geometry -> Dissolve 

9. Valitaan sulatuksen parametrit 

• Dissolve Fields [optional] -> Layer 
• Tallennetaan väliaikaisena, 

 -> Run. 

10. Poistetaan turhat atribuutit. Tarpeellisia tasoja on vain alkuperäistä kohteen käytötarkoitusta ilmaiseva 
tieto (layer) ja uniikki tunniste. (FID, tai ID). Avataan tason välilehti. Attribute table -> Delete fields 

 
Kuva 69. Turhien kenttien poisto. 

10. Luodaan ”mluokka” -maankäyttöa kuvaava attribuutti. -> Add field 

Valitaan uuden kentän parametrit: 

• Name -> mluokka 
• Type -> Text 
• Lenght -> 30 

-> Ok. 
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Kuva 70. Kentän luominen 

11. Annetaan maastotietokannan kohteille WSSP-luokitus ”mluokka” sarakkeelle. Apuna voi käyttää WSSP-
tietokantaa.  
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12. Rikotaan työstettävä taso dissolved yksiosaiseksi- multipart split liitännäisen avulla. Työkalu löytyy 
asennuksen jälkeen digitointityökaluriviltä. Kytketään muokkaus päälle ja valitaan työkaluriviltä: Split 
feature parts  

 
Kuva 71. Taso maalataan, editointi kytketään päälle ja kohteet rikotaan liitännäisen avulla. 

13. Viedään taso pysyväksi. Avataan tason välilehti. Export -> Save as -> Select Fields to export and their 
export options -> “Fid” -kenttää ei viedä. Tallennetaan nimellä ”maastotietokannan_kohteet” 
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Täydentäminen Luonnonvarakeskuksen aineistoilla 
Metsäköyhällä tai urbaanilla alueella ei metsäaineistoa välttämättä tarvitse hyödyntää.  

1. Ladataan karttalehdittäin metsä-aineistot LUKE latauspalvelusta. Lähtöaineistona metsien 
määrittämisessä toimii ”Puuston latvuspeittävyys koko puusto 2019” ja ”Puuston keskipituus 2019 (dm)” 
Uusinta aineistoa suositaan. Mikäli alueelta ei ole aineistoa saatavilla, on luotettava aiempien vuosien 
aineistoihin. 

2. Puretaan ainestot ja tiputetaan ne työtilaan. Mikäli alue on useamman karttalehden alueella, on aineisto 
yhdistettävä. Toistetaan prosessi tarvittaessa molemmille lähtöaineistoille, puuston keskipituudelle ja -
latvuspeitteisyydelle. Processing-> Processing toolbox -> GDAL->Raster Miscellaneous-> Merge  

3. Leikataan rasteri aineistot. Toistetaan prosessi molemmille lähtöaineistoille, puuston keskipituudelle ja -
latvuspeitteisyydelle. Raster->Extraction -> Clip raster by Mask layer 

• Input layer -> Puuston latvuspeittävyys koko puusto 2019” ja ”Puuston keskipituus 2019 (dm)”  
• Mask layer -> ”korjaamaton_maankäyttö” 
• match extent of the clipped raster to the extent of the mask layer ->  
• Tallennetaan tasot nimillä “peitto” ja “pituus” 

4. Luokitellaan peitto uudelleen.  Processing -> GRASS -> Raster(r*) ->r.reclass 

5. Valitaan luokittelun parametrit:  

• Input raster layer  -> ”Peitto” 
• Kirjataan uudelleenluokittelun säännöt. Tarkoituksena on luokitella alle 10 % peittävyyden omaavat 

alueet nollaksi ja yli 10 % omaavan arvon yhdeksi.  

Sääntö on: 

0 thru 10 = 0 

10 thru 100 = 1 

-> Run. 

https://kartta.luke.fi/opendata/valinta.html
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Kuva 72. Metsän peitteisyyden uudelleenluokittelu. 

6. Toistetaan uudelleenluokittelun prosessi ”pituus” rasterille. Valitaan määritystyökalu.  Processing -> 
GRASS -> Raster(r*) -> r.reclass 

7. Valitaan uudelleen luokittelun parametrit: 

• Input raster layer -> ”pituus” 
• Kirjataan uudelleenluokittelun säännöt. Tarkoituksena on luokitella alle 5 metriä korkeat alueet 

nollaksi ja yli 5 metriä korkeat alueet yhdeksi. (Lähtöaineisto on desimetreinä) 

Sääntö on: 

0 thru 50 = 0 

50 thru 1000 = 1 

-> Run. 
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Kuva 73. Pituuden uudelleen luokittelun säännöt. 

  



 

88 
 

10. Lasketaan ”peitto” ja ”pituus” yhteen, jotta voidaan muodostaa metsät. Raster-> Raster Calculator  

• Laskentaikkunaan -> ”reclassified”+”reclassified” (uudelleenluokitellut peitto ja pituus) 
• Output layer-> Tallennetaan ja nimetään tunnistettavalla tavalla  

->  Ok. 

 
Kuva 74. Rasterilaskimen parametrit. 

Kaikki arvon 2 ylittävät hilat voivat olla nyt metsiä, WSSP:n määritelmän mukaan. Kaikki alle 2 alittavat 
arvot eivät voi olla WSSP:n määritelmän mukaan metsiä. 
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Kuva 75. Tulos. Kaikki arvon 2 ylittävät hilat voivat olla nyt metsiä, WSSP:n määritelmän mukaan 

11. Muunnetaan aineisto rasterista vektoriksi. Raster -> Conversion -> Polygonize (raster to vector) 

• Tallennetaan väliaikaisena 

-> Run. 

11b. Tarvittaessa leikataan vektorimuotoinen metsätaso tarkasteltavan alueen rajoilla (yleiskaavan rajoilla, 
tai valuma-alueen rajoilla) Processing-> Processing toolbox-> Vector overlay-> Clip  

12. Avataan äsken luodun tason Vectorized attribuuttitaulukko ja kytketään muokkaus päälle. Järjestetään 
”DN”-kenttä alimmasta suurimpaan. Maalataan kaikki kahden alittavat arvot ja poistetaan ne. 
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Kuva 76. Parametrien alittavien arvojen poisto. 

 

Kohteiden on muodostettava 20 metriä leveitä ja 5000 neliömetriä laajoja sekä yhtenäisiä kokonaisuuksia, 
jotta WSSP:n määritelmän mukaan ne olisivat metsäalueita. 

13. Lasketaan alueiden pinta alat, ja poistetaan parametrien alle jäävät arvot. Avataan vectorized välilehti -
> calculate geometry  

14. Poistetaan kaikki alle 0,5 HA kohteet. Avataan tason attribuuttitaulukko ja kytketään muokkaus päälle. 
Järjestetään ”area” -sarake alimmasta suurimpaan. Maalataan kaikki alle 5000 arvot ja poistetaan ne. 

15. Poistetaan kaikki alle 0,5 HA reiät. Maalataan koko taso ja kytketään editointi päälle. Edit. Processing-> 
Processing toolbox-> Vector-geometry -> Delete holes -> Remove holes less than -> 5000 

-> Run. 
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Kuva 77. Metsäalueiden reikien poisto. 

 
Kuva 78. Vasemmalla "reikäinen" metsätaso ja oikealla "reiätön" metsätaso. Vasemmalla on myös käytetty 20 % latvuspeitteisyyttä metsän 
määrittämiseksi. 

16. Luodaan ”mluokka” -maankäyttöä kuvaava attribuutti, äskettäin tuotetulle ”cleaned” tasolle. -> Add 
field 

Valitaan uuden kentän parametrit 
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• Name -> mluokka 
• Type -> Text 
• Lenght -> 30 

-> Ok. 

17. Annetaan WSSP-luokitus ”mluokka” sarakkeelle. Kirjoitetaan riville -> Metsäalueet 

18. Viedään taso pysyväksi. Avataan tason välilehti. Export -> Save as. Tallennetaan nimellä ”metsät” 

19. On suositeltavaa, että tulosta verrataan ilmakuvaan. Erityistä huomiota vaativat korkeat sekä peitteiset 
rakenteet, kuten esimerkiksi voima-, sähkölinjat sekä jakeluasemat. Korjaaminen tehdään digitoimalla. 

 
Kuva 79. Metsätaso voimalaitoksen yläpuolella. Puuta muistuttavat rakenteet tuottavat vääristymiä. 
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Korjatun maankäytön luominen 
Korjattu maankäyttö noudattaa seuraavaa hierarkiaa: maastotietokanta on tarkin, sitten metsätaso ja 
viimeisenä yleiskaava. 

1. Etsitään metsien ja maastotietokannan erotus. Processing-> Processing toolbox -> Vector overlay -> 
Difference 

2. Valitaan erotuksen parametrit 

• Input layer -> ”metsät” 
• Overlay layer -> ”maastotietokannan_kohteet” 

-> Run. 

3.Yhdistetään vektorit erotus ja maastotietokannan_kohteet. Processing-> Processing toolbox ->Vector 
general -> Merge vector layers  

• Input layers -> maastotietokannan_kohteet ja difference 
• Tallennetaan väliaikaisena.   

-> Run. 

Avataan tason välilehti ja nimetään tulos uudelleen. Rename -> ”maasto_metsä” 

4. Poistetaan tai nimetään uudelleen difference tunnistettavalla nimellä 

5. Etsitään yleiskaavan (korjaamaton_maankäyttö) ja täydentävän aineiston (maasto_metsä) erot. 
Processing-> Processing toolbox -> Vector overlay -> Difference 

6. Valitaan erotuksen parametrit 

• Input layer -> korjaamaton_maankäyttö 
• Overlay layer -> maasto_metsä 

-> Run. 

7. Yhdistetään. Processing-> Processing toolbox ->Vector general -> Merge vector layers  

• Input layers -> maasto_metsä ja difference 
• Tallennetaan väliaikaisena.  

-> Run. 

Avataan tason välilehti ja nimetään tulos uudelleen. Rename -> ”Lähes_korjattu_maankäyttö” 

8. Sulatetaan ”Lähes_korjattu_maankäyttö”. Processing -> Processing toolbox -> Vector Geometry -> 
Dissolve 

9.Valitaan sulatuksen parametrit: 

• Dissolve Fields [optional] -> mluokka 
• Tallennetaan väliaikaisena. 

 -> Run. 
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10. Tarkistetaan dissolved uniikki tunniste. Uniikin tunnisteen puuttuessa, viedään taso pysyväksi ilman fid 
tai ID  ominaisuustietoa. Export -> Save as. Rikotaan dissolved -taso yksiosaiseksi multipart split liitännäisen 
avulla. Työkalu löytyy asennuksen jälkeen digitointityökaluriviltä. -> Split feature parts. 

10. Lasketaan kaikki alle 0,5 hehtaarin kohteet. Avataan tason välilehti -> Calculate geometry  

11. Sulatetaan kaikki alle 0,5 HA kohteet osaksi sitä kohdetta, jonka kanssa kohde jakaa pisimmän rajan. 
Avataan tason attribuuttitaulukko. Muokkaus kytketään päälle. Järjestetään ”area”-kenttä alimmasta 
suurimpaan. Maalataan kaikki arvot, jotka jäävät alle 5000. Haetaan eliminointityökalu. Processing -> 
Processing toolbox -> Eliminate selected polygons 

12. Valitaan eliminoinnin parametrit 

• Merge selection with the neighbouring polygon with the -> Largest Common Boundary 
• Tallennetaan nimellä ”korjattu_maankäyttö” 

-> Run. 

 
Kuva 80. Eliminointi. 
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Digitointi ja ilmakuvakorjaus 
Riippuen lähtöaineistojen ajantasaisuudesta ja tarkkuudesta sekä soveltuvuudesta WSSP:en, voi olla 
tarpeellista digitoida korjattua maankäyttöä. Digitoinnin laajuus ja tarkkuus on kiinni käyttäjästä. On 
suositeltavaa käyttää korkearesoluutioista ilmakuvaa korjausta varten. Apuna korjaamisessa voi myös 
hyödyntää Fix geometries ja Remove Dangles työkaluja. Ennen digitoinnin aloittamista kannattaa luoda 
varmuuskopio. Avataan tason korjattu_maankäyttö välilehti -> Export -> saves as. Tallennetaan nimellä 
”Varmuuskopio_korjattu_maankäyttö” 

 
Kuva 81. Ylempänä WMS-palvelu ja alempana ladattu rasteritaso. 
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Muutosalueiden määritys 
Muutosalueet ovat niitä alueita, jotka tulevat muuttumaan hydromorfologiselta luonteeltaan niin paljon, 
ettei niitä voi pitää enää samana maankäyttömuotona. Muutosalueet määritetään vertaamalla 
korjaamatonta ja korjattua maankäyttöä keskenään. 

1. Etsitään leikkauskohdat. Processing -> Processing toolbox -> Vector overlay -> Intersection 

2. Valitaan leikkauskohtien parametrit: 

• Input layer -> “korjaamaton_maankäyttö” 
• Overlay layer -> ”korjattu_maankäyttö” 
• Input fields to keep (Leave empty to keep all fields) [Optional] -> fid, mluokka 
• Overlay fields to keep (Leave empty to keep all fields) [Optional] -> mluokka 
• Overlay fields prefix [optional] -> nyk_ 

-> Run. 

 
Kuva 82. Muutosalueiden paikantamisen parametrit. 
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3. Etsitään muutosalueet. Avataan luodun tason attribuuttitaulu ja kenttälaskin. Attribute table -> Field 
calculator  

4. Valitaan uuden kentän parametrit 

• Create a new field -> 
• Output field name -> ”muutos” 
• Output field type -> Whole number (integer) 

Kopioidaan kenttälaskimeen lauseke: 

 "mluokka" = "nyk_mluokka" 

-> Ok. 

Nyt kentän muutos edustaa muutosalueita. Arvot 0 ovat muutosalueita ja nollan ylittävät arvot (1) 
muuttumattomia alueita. 

 
Kuva 83.  Muutosalueiden laskeminen kenttälaskimen avulla. 
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Kuva 84. Arvot 0 ovat muutosalueita, ja nollan ylittävät arvot (1) muuttumattomia alueita. 

Mluokka osoittaa kaavan osoittaman WSSP-maankäyttöluokan. Nyk_mluokka edustaa nykytilan mukaista 
maankäyttöä, korjatun maankäytön mukaisesti. Muutos osoittaa onko alue muuttumassa vai ei. 

5. Rikotaan taso yksiosaiseksi multipart split liitännäisen avulla. Työkalu löytyy asennuksen jälkeen 
digitointityökaluriviltä. -> Split feature parts 

6. Avataan attribuuttitaulu ja korjataan käsin: 

• Poistetaan kaikki arvon ”1” omaavat kohteet (nämä eivät ole muutosalueita). 
• Lasketaan kohteiden pinta-ala, ja poistetaan kaikki 0,5 hehtaarin kohteet. (Calculate geometry). 
• Poistetaan kaikki arvot, joilla ei ole kaavan osoittamaa maankäyttöluokkaa (kaavattomat alueet). 
• Poistetaan kaikki tason osoittamat muutokset avoimista viheralueista metsiksi. (WSPP ei pysty 

osoittamaan muutoksia viheralueista metsiksi, johtuen lähtöaineiston tarkkuudesta). Aineisto 
voidaan järjestää uudelleen työskentelyn helpottamiseksi attribuuttitaulukossa. 

• Tarkastellaan erityisalueiden muutokset ja poistetaan paikkaansa pitämättömät tulokset. 
• Erityistä huomiota kaipaavat kaavan maa ja metsätalouden piiriin kuuluvat alueet. Näiden 

muutoksia ei välttämättä saada näkymään, metsistä maatalouden alueiksi ja päinvastoin. Kohteet 
tulee poistaa. 

• Käytetään maalaisjärkeä ja paikkatuntemusta. Menetelmä on ainoastaan niin tarkka kuin 
lähtöaineistot. 
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Kuva 85. Pilottialueen muutosalueet. 
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WSSP-riskimoduuli 

 
Kuva 86. Yhteenlaskettu hulevesiin kohdistuva riski pilottialueella, ilman ihmistoimintaa. 

Tiivistelmä 
On suositeltavaa luoda erillinen työtila riskien kokoamista varten. Moduulin avulla voidaan arvioida 
hulevesiin kohdistuvia biofyysisiä ja ihmistoiminnan aiheuttamia riskejä, ja kohdistaa toimenpiteitä 
resurssiviisaasti. 

WSSP-riskit voidaan periaatteessa laskea minkä tahansa kokoiselle alueelle, mutta työmäärä voi kasvaa. 
Ainoastaan ihmistoiminnan riski ei skaalaudu, sillä laskuja rajoittaa yleiskaavan kattavuus. Ohjeissa riski 
lasketaan aiemmin tuotetulle ”yhdistetty_korkeusmalli” tasolle. Tämä taso toimii riskiaineiston rajoina. 
Rajoina voidaan myös käyttää kansallisia karttalehtiä.  Moduulin tavoitteena on: 

• Luoda riskirasterit kuvaamaan 1. kasvillisuutta, 2. kaltevuutta, 3. läpäisemättömyyttä, 4. maaperän 
vedenjohtavuutta, 5. etäisyyttä valuntaverkkoon ja 6. ihmistoimintaa 

• Luoda yhteenlaskettu riskirasteri 

Moduulissa tarvittavat lähtöaineistot: 

• NVDI:n maksimiarvot 2021 [SYKE] 
• Korkeusmalli 2 m [MML] 
• Imperviousness [EEA] 
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• Maaperä 1:20 000 / 1:50 000 [GTK] 
• Polttotaso [WSSP] 
• WSSP-maankäyttöluokittelu [WSSP] 

Riskiarvot (r.reclass, reclassify by table) ovat vaihdettavissa harkinnanvaraisesti. Ohjeissa esitetyt arvot 
ovat WSSP-tietokannassa tarkemmin perusteltuja lukuja väliltä 0–5.  

Esivalmistelut 
1. Luodaan työtila. Tiputetaan työtilaan yhdistetty_korkeusmalli (Mikäli tiedostoa ei ole, luodaan tämä 
noudattamalla WSSP valuma-aluemoduulin ohjeita.  

2. Tallennetaan työtila nimellä ”WSSP_riski” 

3. Tarkistetaan sijainti. -> World. 

4. Luodaan maskitaso riskirastereiden leikkaamista varten. Processing ->Processing Toolbox-> Raster 
creation -> Create constant raster layer 

Valitaan maskitason parametrit: 

• Desired extent -> yhdistetty_korkeusmalli 
• Pixel size -> 10 
• Constant value -> 1 
• Tallennetaan väliaikaisena 

-> Run. 
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Kuva 87. Maskitason parametrit. 

5. Muutetaan rasteri vektoriksi Processing-> Processing toolbox -> GDAL->Raster conversion -> Polygonize 
(raster to a vector) 

Valitaan muuntoparametrit: 

• Input layer -> constant 
• Tallennetaan nimellä ”maski” 

-> Run. 
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Kuva 88. Maskitason polygonisoinnin parametrit. 

Kaltevuus 
Kaltevuus lasketaan käsittelemättömästä MML- KM2 aineistosta. Laskemisessa hyödynnetään aiemmin 
ladattua ja yhdistettyä korkeusmallia, jota ei ole poltettu ”yhdistetty_korkeusmalli”. Aineisto käy myös 
muun aineiston rajaajana. 

1. Haetaan kaltevuuden laskentatyökalu. Processing -> Processing Toolbox-> Raster terrain analysis-> Slope 

2. Valitaan kaltevuuden laskennan parametrit: 

• Elevation layer -> ”yhdistetty_korkeusmallí” 
• Z factor -> 1  
• Tallennetaan väliaikaisena 

 -> Run. 
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Kuva 89. Kaltevuuden laskentatyökalu. 

 

3. Luokitellaan kaltevuuden astearvot WSSP-riskiarvoiksi.  Processing Toolbox-> Raster-> GRASS -> 
Raster(r.*) -> r.reclass 

Valitaan uudelleen luokittelun parametrit: 

• Input raster layer -> slope 
• Reclass rules text -> Kopioidaan sääntö reclassify rules -ikkunaan. 
• Tallennetaan nimellä ”kaltevuus_riski” 

Sääntö on: 

0 thru 1 = 0 

1 thru 4 = 3 

4 thru 90 = 5 

-> Run. 
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Kuva 90. Kaltevuuden uudelleen luokittelun säännöt. 

 

 
Kuva 91. Kaltevuus WSSP:n riskiluokittelun mukaan. 
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Maalajin hydrologinen läpäisevyys 
Riskiluokittelun pohja-aineistona toimii GTK:n ”Maaperä 1:20 000 / 1:50 000” aineisto. WSSP riskiluokittelu 
perustuu GTK:n antamiin vedenjohtavuusarvoihin. 

1. Ladataan aineisto GTK:n rajapintapalvelusta Maaperä 1:20 000 / 1:50 000 aineisto. 

2. Puretaan ja tiputetaan aineisto työtilaan. Valitaan mp20k_maalajit. Muut kohteet ovat tarpeettomia. -> 
Add layers. 

 
Kuva 92. Tarvittavat kohteet GTK:n aineistoista. 

3. Leikataan aineisto. Processing -> Processing Toolbox ->GDAL -> Vector geoprocessing -> Clip vector by 
extent  

4. Valitaan leikkauksen parametrit: 

• Input layer -> juuri ladattu mpk20k_maalajit 
• Extent -> yhdistetty_korkeusmalli 
• Tallennetaan väliaikaisena. 

-> Run. 

5. Avataan tason clipped attribuuttitaulu ja kenttälaskin. Luodaan uusi kenttä riskiluokittelua varten. 
Attribute table -> Field calculator  

  

https://hakku.gtk.fi/fi/locations/search
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6. Valitaan uuden kentän parametrit: 

• Create a new field ->  
• Output field name -> HL 
• Output field type -> Whole number (integral) 

Kopioidaan seuraava lauseke kenttälaskimen ikkunaan: 

CASE 

WHEN "PINTAMAALAJI"  = 'Hienoainesmoreeni (HMr) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Kalliomaa (Ka) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Kartoittamaton (0)' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Lieju (Lj) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Liejuhiesu (LjHs) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'liejuinen Hiekka (LjHk) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Hienoainesmoreeni (HMr) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'liejuinen hieno Hieta (LjHHt) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Liejusavi (LjSa) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Rakka (RaKa) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Rapakallio (RpKa) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Savi (Sa) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Turvetuotantoalue (Tu) RT' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Täytemaa (Ta)' THEN '5' 

WHEN "PINTAMAALAJI"  = 'Hiekkamoreeni (Mr) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'hieno Hiekka (HHk) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'hieno Hieta (HHt) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'Hiesu (Hs) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'karkea Hieta (KHt) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'Rahkaturve (St) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'Saraturve (Ct) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'Soramoreeni (SrMr) RT' THEN '3' 

WHEN "PINTAMAALAJI"  = 'Hiekka (Hk) RT' THEN '0' 

WHEN "PINTAMAALAJI"  = 'Kiviä (Ki) RT' THEN '0' 

WHEN "PINTAMAALAJI"  = 'Lohkareita (Lo) RT' THEN '0' 
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WHEN "PINTAMAALAJI"  = 'Sora (Sr) RT' THEN '0' 

WHEN "PINTAMAALAJI"  = 'Vesi (Ve)' THEN '0' 

ELSE NULL 

END 

-> OK. 

Lauseke sisältää kaikki mp20k_maalajit – pintamaalajiluokkien arvot ja muuntaa ne automaattisesti WSSP-
riskiluokkia vastaaviksi arvoiksi. Mikäli lähtöaineisto eriää, on lauseketta muokattava.  

 
Kuva 93. Maaperän riskiluokittelu kenttälaskimessa. 

7. Muutetaan vektori rasteriksi. Haetaan työkalu. Processing -> GDAL -> Vector conversion -> Rasterize 
(Vector to Raster) 

8. Valitaan muunnoksen parametrit.  

• Input layer -> Clipped 
• Field to use a burn-in value [optional] -> juuri luotu attribuutti “HL”  
• Output raster size units -> Georeferenced units (yksikköjen tulee olla metrejä) 
• Height/ Horizontal resolution -> 2  
• Width/ Vertical resolution -> 2 
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• Output extent [optional] -> “yhdistetty_korkeusmalli” 
• Assign a specified nodata value to output bands [optional] -> not set 
• Tallennetaan nimellä ”maaperan_hydrologinen_johtavuus_riski” 

-> Run. 

 
Kuva 94. Maaperävektorin muuntaminen rasteriksi. 

 

Läpäisemättömyys 
Läpäisemättömyys lasketaan WSSP:sa TIA:lla. Lähtöaineistona toimii yleiseurooppalainen European 
Enviromental Agency:n tuottama Imperviousness, jossa läpäisemättömyys on kuvattu prosentteina.  

1. Ladataan European enviromental agency läpäisemättömyysaineisto. 

2. Puretaan aineisto ja tiputetaan työtilaan riittävä määrä tasoja. Poistetaan ylimääräiset tasot. 

https://land.copernicus.eu/pan-european/high-resolution-layers/imperviousness/status-maps/imperviousness-density-2018?tab=download
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3. Yhdistetään tasot, mikäli tarpeellista. Processing-> Processing toolbox -> GDAL->Raster Miscellaneous-> 
Merge 

4. Leikataan rasteritaso. Processing -> Processing toolbox – GDAL -> Raster Extraction -> Clip raster by Mask 
layer. 

6. Valitaan leikkauksen parametrit 

• Input layer -> “Reprojected” (projektoitu läpäisemättömyysaineisto) 
• Mask layer -> ”Clipped” (maaperästä leikattu aiemman työvaiheen taso)  
• Match the extent of the clipped raster ->   
• Tallennetaan väliaikaisena. 

-> Run. 

 
Kuva 95. Läpäisemättömyysaineiston leikkauksen parametrit. 

7. Projektoidaan valtiolliseen koordinaatistoon ja muunnetaan hilakoko. Processing -> Processing toolbox – 
GDAL -> Raster projections -> Warp (reproject)  

8. Valitaan uudelleen projektoinnin parametrit: 
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• Input layer -> Läpäisemättömyysaineisto 

• Target CRS [optional] -> EPSG:3067, ETRS-TM35FIN 

• Output file resolution in target georeferenced units [optional] -> 2 

• Tallennetaan väliaikaisena. 

-> Run. 

 

9. Luokitellaan aineisto WSSP:n mukaisiin riskiluokkiin. Processing ->Processing toolbox -> GRASS -> 
Raster(r*) ->r.reclass  

Valitaan uudelleen luokittelun parametrit 

• Reclass rules text -> Kopioidaan alempi sääntö reclassify rules ikkunaan. 
• Tallennetaan nimellä ”läpäisemättömyys_riski” 

Sääntö on: 

0 thru 1 = 0 

1 thru 20 = 1 

20 thru 40 = 2 

40 thru 60 = 3 

60 thru 80 = 4 

80 thru 100 = 5 

-> Run. 
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Kuva 96. Läpäisemättömyyden uudelleenluokittelun säännöt. 
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Kuva 97. Läpäisemättömyys WSSP:n riskiluokittelun mukaan. 

NDVI 
Normalisoitu kasvillisuusindeksi luokitellaan uudelleen SYKEN tuottamasta aineistosta. Vaihtoehtoisesti 
”NDVI:n maksimiarvo 2021 Etelä-Suomi” tai/ja ”NDVI:n maksimiarvo 2021 Pohjois-Suomi”. Rajatapauksissa 
molemmat. 

 
1. Ladataan SYKE NDVI:n maksimiarvo 2021.  Puretaan aineisto ja raahataan työtilaan tarkasteltavan 
alueen kattava määrä tasoja.  

2.  Yhdistetään tasot, mikäli tarpeellista. Processing-> Processing toolbox -> GDAL->Raster Miscellaneous-> 
Merge 

https://www.syke.fi/fi-FI/Avoin_tieto/Paikkatietoaineistot/Ladattavat_paikkatietoaineistot
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3. Leikataan taso ja muunnetaan koordinaatisto. Processing-> Processing toolbox -> GDAL-> Raster 
extraction -> Clip raster by mask layer 

Valitaan leikkauksen parametrit 

• Input layer -> NDVI:n maksimiarvo 2021, tai yhdistetty taso. 
• Target CRS -> EPSG:3067, ETRS-TM35FIN 
• Mask layer -> maski (esivalmisteluina luotu maskitaso). 
• Match the extent of the clipped raster ->  
• Set output file resolution ->  
• X Resolution to output bands [optional] -> 2 
• Y Resolution to output bands [optional] -> 2 
• Tallennetaan väliaikaisena. 

4. Luokitellaan aineisto uusiksi. Processing -> Processing toolbox -> GRASS -> Raster(r*) ->r.reclass  

Valitaan uudelleen luokittelun parametrit 

• Kopioidaan alempi sääntö reclassify rules ikkunaan. 
• Tallennetaan nimellä ”NVDI_riski”. 

Sääntö on: 

0 thru 120 = 5 

120 thru 140 = 4 

140 thru 160 = 3 

160 thru 180 = 2 

180 thru 200 = 1 

200 thru 2000 = 0 

-> Run. 

Etäisyys valuntaverkkoon 
Riski lasketaan WSSP valuma-aluemoduulin aikana luodusta polttotasosta. Mikäli polttotasoa ei ole luotu, 
se pitää luoda.  

1. Tiputetaan ”polttotaso” työtilaan. 

2. Puskuroidaan polttotasoa 100 metrillä ja 200 metrillä. Processing-> Processing toolbox -> Vector 
geometry -> Buffer 

3. Valitaan puskuroinnin parametrit: 

• Input layer -> polttotaso 
• Distance -> 100 
• Dissolve result ->  
• Tallennetaan väliaikaisena 
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-> Run. Ei suljeta työkalua. Tarkistetaan tulos ja nimetään taso uudelleen -> Rename layer -> ”100”  
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4. Puskuroidaan toisen kerran polttotasoa: 

Valitaan puskuroinnin parametrit: 

• Input layer -> polttotaso 
• Distance -> 200 
• Dissolve result ->  
• Tallennetaan väliaikaisena.  

-> Run. Tarkistetaan tulos ja nimetään taso uudelleen -> Rename layer -> ”200”  

 

 
Kuva 98. Etäisyyden puskurointi. 
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5. Erotetaan tasosta ”200” taso ”100.” Haetaan työkalu. Processing-> Processing toolbox ->Vector overlay -
> Difference 

6. Valitaan erotuksen parametrit: 

• Input layer -> 200 
• Overlay layer -> 100 
• Tallennetaan väliaikaisena. 

-> Run. 
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Kuva 99. Etäisyyden erotuksen parametrit. 
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Kuva 100. Puskuroinnin erotus. 

7. Yhdistetään vektorit. Processing-> Processing toolbox ->Vector general -> Merge vector layers 

8. Valitaan yhdistämisen parametrit: 

• Valitaan yhdistettäväksi 100 ja difference 
• Tallennetaan tilapäisenä. 

 -> Run. 

9. Luodaan riskiarvoa varten uusi kenttä. Avataan tason ”merged” välilehti. -> Attribute table -> edit -> new 
field 

Valitaan uuden kentän parametrit: 

• Name -> R 
• Type -> Whole number (integer) 
• Length -> 10 
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-> OK. 

10. Asetetaan attribuuttitaulukon kautta kentän ”R” arvoksi 5 ja 3, etäisyyden mukaisesti. 100 metrille 
annetaan riskiarvo 5 ja 200 metrille annetaan riskiarvo 3. 

11.  Korjataan kentän ”fid” arvot eriarvoisiksi. Muuten rasterointi ei toimi. 

 
Kuva 101. Riskiarvon asettaminen layer tiedon avulla. 

 
Kuva 102. Riskiarvon voi myös asettaa kiinnittämällä attribuuttitaulukon työtilaan ja maalaamalla kohteen. 

12. Muutetaan vektori rasteriksi. Haetaan työkalu. Processing -> Processing toolbox -> GDAL -> Vector 
conversion -> Rasterize (Vector to raster) 
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13. Valitaan muunnon parametrit: 

• Input layer -> ”Merged” 
• Field to use a burn-in value [optional] -> juuri luotu attribuutti “R” 
• Output raster size units -> Georeferenced units (yksikköjen tulee olla metrejä) 
• Height/ Horizontal resolution -> 2  
• Width/ Vertical resolution -> 2 
• Output extent [optional] -> “yhdistetty_korkeusmalli” 
• Assign a specified nodata value to output bands [optional] -> not set 
• Tallennetaan nimellä ”Etaisyyden_riski” 

 
Kuva 103. Etäisyyden muunnon parametrit. 

 

Maankäyttöluokkakohtaisen ihmistoiminnan aiheuttama riski 
Riski lasketaan hyödyntäen maankäyttö ja muutosaluemoduulissa luotua ”korjattua maankäyttöä” 
Jokaiselle luokalle on HULVATUSSA arvioitu luokkakohtainen riski. 

Erityisalueet tulee arvottaa aluekohtaisesti. Lausekkeessa on riskiarvo 3.0, mutta sitä voidaan muuttaa 
joko lausekkeessa itsessään tai myöhemmin käsin attribuuttitaulukon kautta. 
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1. Tuodaan WSSP-maankäyttötaso (korjattu_maankäyttö) työtilaan. 

2. Luodaan riskiarvoa varten uusi kenttä. Avataan tason välilehti. Attribute table -> Field calculator  

Valitaan uuden kentän parametrit 

• Create a new field -> 
• Output field name -> ”R” 
• Output field type -> Decimal Number (real) 
• Kopioidaan lauseke kenttälaskimeen: 

Kopioitava lauseke: 

CASE 

WHEN "mluokka"  = 'Väljät asuinalueet' THEN '2.3' 

WHEN "mluokka"  = 'Tiiviit asuinalueet' THEN '3.2' 

WHEN "mluokka"  = 'Keskusta-alueet' THEN '4.2' 

WHEN "mluokka"  = 'Työ- ja teollisuusalueet' THEN '4.0' 

WHEN "mluokka"  = 'Palvelualueet' THEN '3.0' 

WHEN "mluokka"  = 'Avoimet viheralueet' THEN '1.7' 

WHEN "mluokka"  = 'Metsäalueet' THEN '1.3' 

WHEN "mluokka"  = 'Liikennealueet' THEN '3.5' 

WHEN "mluokka"  = 'Kenttäalueet' THEN '2.0' 

WHEN "mluokka"  = 'Maatalousalueet' THEN '3.8' 

WHEN "mluokka"  = 'Vesialueet' THEN '0.5' 

WHEN "mluokka"  = 'Erityisalueet' THEN '3.0' 

END 

3. Tarkistetaan tulos attribuuttitaulukosta. Tyhjiä arvoja ei pitäisi olla, mikäli ohjeita on noudatettu. Mikäli 
tyhjiä arvoja on, niin lausekkeessa on virhe tai vektoritasossa on eriäviä parametrejä. 

Tämä tarkoittaa sitä, että lauseketta tai vektoritasoa on muunnettava vastaamaan toisiaan. Esimerkiksi 
maankäyttömuodon tulee olla juuri maatalousalueiden kohdalla ”Maatalousalueet”. Mikään muu arvo, 
kuten ”maatalousalueet” tai ”peltoalueet”, ei tuota tulosta.  

CASE 

WHEN "attribuutin nimi"  = 'maankäyttömuoto' THEN 'riskiarvo' 

END 

4. Muutetaan vektori rasteriksi. Processing -> Processing Toolbox -> GDAL -> Vector conversion -> Rasterize 
(Vector to Raster) 
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Valitaan muunnoksen parametrit.  

• Input layer -> ”korjattu_maankäyttö” 
• Field to use a burn-in value [optional] -> juuri luotu attribuutti “R” 
• Output raster size units -> Georeferenced units (yksikköjen tulee olla metrejä) 
• Height/ Horizontal resolution -> 2  
• Width/ Vertical resolution -> 2 
• Output extent [optional] -> “yhdistetty_korkeusmalli” 
• Assign a specified nodata value to output bands [optional] -> not set 
• Tallennetaan nimellä ”Ihmistoiminnan_riski”. 

 

Riskin yhteen laskeminen 
Riskeistä voidaan muodostaa yhtenäinen riskirasteri. Kaksi tai enemmän riskejä voidaan laskea yhteen. 
Yhteenlaskettuun rasteriin voidaan lisätä arvoja myöhemmin. 

1. Tarkastetaan kaikki lasketut riskiä kuvaavat rasteritasot ja luokitellaan ne uudelleen virhearvojen 
poistamiseksi. (Pilotoinnissa esiintyi joko virhe, tai ominaisuus, jonka luonne jäi selvittämättä. Tämä tuotti 
virheellisiä laskutuloksia yhteenlaskettaessa). Toistetaan prosessi jokaiselle tasolle. 

 
Kuva 104. Virheellinen yhteenlaskun tulos, joka johtuu siitä, että taso tai useampi taso sisältää virheellisiä arvoja. 

2. Avataan tarkasteltavan tason välilehti. -> Properties -> Symboloy-> Render type -> Paletted/Unique 
values -> Classify. 



 

124 
 

 
Kuva 105. Rasteritason symbolit 

3. Haetaan rasterilaskin työkaluriviltä Raster-> Raster calculator  
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Kuva 106. Rasterilaskin. 

4. Valitaan rasterilaskurin parametrit: 

• Raster bands ja Operators-> Valitaan tasot ja asetetaan plusmerkki jokaiseen väliin.  
• Output layer -> Nimetään yhteenlaskettujen riskitasojen mukaisesti, tunnistettavalla tavalla, 

”Riski_ilman_ihmistoimintaa”, tai ”Riski_yhteenlaskettu”  
• Spatial extent -> Tarkistetaan X ja Y koordinaatit. Koordinaatiston on oltava jaettavissa kahdella. 
• Output CRS -> Tarkistetaan koordinaattijärjestelmä EPSG:3067, ETRS-TM35FIN  
• Resolution -> Tarkistetaan hilakoko. 

-> Ok. 



 

126 
 

 
Kuva 107. Rasterilaskimen parametrit. Kuvassa viimeisen ja toiseksi viimeisen tason väliltä puuttuu plusmerkki, joten lauseke ei ole validi. 

 

5. Mikäli tarpeen, tulosta voidaan muotoilla. Tämä kohta voidaan ohittaa, mikäli tulosta ei ole tarpeen 
tarkastella työtilassa, tai siitä ei tehdä taittoa. Avataan tason välilehti -> Properties -> Symboloy-> Render 
type -> Paletted/Unique values -> Classify. -> Color Ramp -> Viridis tai Spectral -> Invert color ramp tarpeen 
vaatiessa. 
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Pohjavesialueet ja Happamat sulfaattimaat 
Happamat sulfaattimaat voidaan tarkistaa GTK:n rajapinnoista, ja pohjavesialueet SYKEN rajapinnoista. 
Pohjavesialueet on huomioitava aina tapauskohtaisesti, eikä niille siksi voida antaa riskiarvoa. Happamat 
sulfaattimaat eivät tuota riskiä, mikäli ne pysyvät luonnontilaisina.  

Tulvariski 
Tulvariski hankitaan SYKEN 2023 julkaisemasta hulevesien tulvariskipalvelusta, tai hankitaan 
konsulttityönä. Tulvariskikartat eivät olleet saavutettavia pilotoinnin aikana. QGIS:n tulvasimulointia ei 
saatu toimimaan pilotoinnin aikana tyydyttävällä tavalla, ja sidosryhmien etujen mukaisesti.  


	Johdanto ja käyttötarkoitus
	Valmistelut ja aineistot
	Ohjeiden käyttö
	Batch processing
	Extent/ GRASS region extent
	Avataan tason välilehti
	Kenttälaskin (Field calculator)
	Aineiston tiputtaminen työtilaan
	Kuvien seuraaminen
	Digitointi
	Tallentaminen väliaikaisena

	Linkit avoimiin aineistoihin
	Liitännäiset
	Liitännäisten asennus
	Yleiskaavan ja hulevesiverkoston tekniset vaatimukset WSSP:sa

	WSSP valuma-aluemoduuli
	Tiivistelmä
	Esivalmistelut ja korkeusmallin luominen
	QGIS- tukeman vektoritiedoston tuominen
	Teknisen piirustuksen tuominen .DWG ja .DFX
	Polttotason täydentävät aineistot
	Polttotason geometrian muuntaminen
	Polttotason yhdistäminen
	Polttotason leikkaaminen
	Korkeusmallin polttaminen
	Muotoilu ja häivyttäminen
	Valuma-alueiden ja uomaverkon määrittäminen r.watershed:lla
	R.watershed
	R.watershed  laskenta-alueen rajaus
	R.water.outlet
	Valuma-alueiden polygonisointi
	Uomien polygonisointi


	WSSP Maankäyttöluokka- ja muutosaluemoduuli
	Tiivistelmä
	QGIS- tukeman vektoritiedoston tuominen
	Teknisen piirustuksen tuominen .DWG ja .DFX
	Pirstaleisen viivamuotoisen geometrian muuntaminen monikulmioksi
	Kaavan käyttötarkoitusta vastaavan tiedon liittäminen monikulmioon sijainnin avulla
	Projektointi
	Yleiskaavan topologisten virheiden korjaus
	Topologinen tarkistus
	Reikien paikkaus ja aineiston leikkaaminen
	Limittäisyyden poistaminen Check Geometries, ja digitoinnin avulla

	Maankäyttöluokittelu
	Maankäyttöluokittelu QGIS:n avulla
	Maankäyttöluokittelu taulukointiohjelman avulla
	Täydentäminen Maanmittauslaitoksen aineistoilla
	Täydentäminen Luonnonvarakeskuksen aineistoilla
	Korjatun maankäytön luominen
	Digitointi ja ilmakuvakorjaus
	Muutosalueiden määritys

	WSSP-riskimoduuli
	Tiivistelmä
	Esivalmistelut
	Kaltevuus
	Maalajin hydrologinen läpäisevyys
	Läpäisemättömyys
	NDVI
	Etäisyys valuntaverkkoon
	Maankäyttöluokkakohtaisen ihmistoiminnan aiheuttama riski
	Riskin yhteen laskeminen
	Pohjavesialueet ja Happamat sulfaattimaat
	Tulvariski


